
 

 

 

 

 

Manual 
Nero Burning ROM 

 



 

 
Nero Burning ROM 2 

 

Copyright and Trademark Information 
This document and all its contents herein are subject to and protected by international copyright and other intellectual property rights 
and are the property of Nero AG and its subsidiaries, affiliates or licensors. All rights reserved. No part of this document may be 
reproduced, transmitted or transcribed without the express written permission of Nero AG. All trade names and trademarks and/or 
service marks are the property of their respective owners. The trademarks mentioned are expressly named for information purposes 
only. Nero AG rejects any claims that transcend the clauses of the guarantee rights to the fullest extent. Nero AG does not undertake 
any liability for the correctness of the content of this document. The contents of the software supplied, as well as of this document, 
may be changed without prior warning. Some applications of the Nero Suites require technologies developed by third-party manufac-
turers. Some of these are included as a trial version in this suite. These technologies need to be activated online (free of charge) or 
by sending an activation fax to have unlimited use of the version. Nero will then undertake to release the data necessary to activate 
technologies licensed by third-party manufacturers for unlimited use with Nero 11 or Nero 11 Platinum. It is therefore necessary to 
have an Internet connection or a fax machine.  
Unless you own the copyright or have permission from the copyright owner, you may be violating national or international copyright 
laws and be subject to payment of damages and other remedies, if you duplicate, reproduce, modify, or distribute copyrighted 
material. If you are unsure of your rights you should contact your legal advisor. 
Copyright © 2011 Nero AG and its licensors. All rights reserved. 
Nero, Nero BackItUp, Nero Burn, Nero Burning ROM, Nero CoverDesigner, Nero Digital, Nero Express, Nero Kwik Media, Nero Kwik 
Backup, Nero Kwik Blu-ray, Nero Kwik Burn, Nero Kwik DVD, Nero Kwik Faces, Nero Kwik Mobile Sync, Nero Kwik Play, Nero Kwik 
Photobook, Nero Kwik Places, Nero Kwik Sync, Nero Kwik Themes, Nero Kwik Tuner, Nero MediaStreaming, Nero Recode, Nero 
RescueAgent, Nero SmartDetect, Nero Simply Enjoy, Nero SmoothPlay, Nero StartSmart, Nero SoundTrax, Nero Surround, Nero 
Video, Nero Video Express, Nero WaveEditor Burn-At-Once, LayerMagic, Liquid Media, SecurDisc, the SecurDisc logo, Superreso-
lution and UltraBuffer are common law trademarks or registered trademarks of Nero AG. 
Gracenote, CDDB, MusicID, MediaVOCS, the Gracenote logo and logotype, and the "Powered by Gracenote" logo are either regis-
tered trademarks or trademarks of Gracenote in the United States and/or other countries. Manufactured under license from Dolby 
Laboratories. Dolby, Pro Logic, and the double-D symbol are registered trademarks of Dolby Laboratories, Inc. Confidential unpub-
lished works. Copyright 2011 Dolby Laboratories. All rights reserved. Manufactured under license under U.S. Patent Nos: 5,956,674; 
5,974,380; 6,487,535 & other U.S. and worldwide patents issued & pending. DTS, the Symbol, & DTS and the Symbol together are 
registered trademarks & DTS Digital Surround, DTS 2.0+Digital Out and the DTS logos are trademarks of DTS, Inc. Product includes 
software. © DTS, Inc. All Rights Reserved. AVCHD and AVCHD logo, AVCHD Lite and AVCHD Lite logo are trademarks of Pana-
sonic Corporation and Sony Corporation. Facebook is a registered trademark of Facebook, Inc. Yahoo! and Flickr are registered 
trademarks of Yahoo! Inc. My Space is a trademark of MySpace, Inc. Google, Android and YouTube are trademarks of Google, Inc. 
Apple, Apple TV, iTunes, iTunes Store, iPad, iPod, iPod touch, iPhone, Mac and QuickTime are trademarks of Apple Inc. registered 
in the U.S and other countries. Blu-ray Disc, Blu-ray, Blu-ray 3D, BD-Live, BONUSVIEW, BDXL, AVCREC and the logos are trade-
marks of the Blu-ray Disc Association. DVD Logo is a trademark of Format/Logo Licensing Corp. registered in the U.S., Japan and 
other countries. Bluetooth is a trademark owned by Bluetooth SIG, Inc. The USB logo is a trademark of Universal Serial Bus Imple-
menters Corporation. ActiveX, ActiveSync, Aero, Authenticode, Bing, DirectX, DirectShow, Internet Explorer, Microsoft, MSN, Out-
look, Windows, Windows Mail, Windows Media, Windows Media Player, Windows Mobile, Windows.NET, Windows Server, Windows 
Vista, Windows XP, Windows 7, Xbox, Xbox 360, PowerPoint, Silverlight, the Silverlight logo, Visual C++, the Windows Vista start 
button, and the Windows logo are trademarks or registered trademarks of Microsoft Corporation in the United States and other 
countries. FaceVACS and Cognitec are either registered trademarks or trademarks of Cognitec Systems GmbH. DivX and DivX 
Certified are registered trademarks of DivX, Inc. DVB is a registered trademark of the DVB Project. NVIDIA, GeForce, ForceWare, 
and CUDA are trademarks or registered trademarks of NVIDIA. Sony, Memory Stick, PlayStation, and PSP are trademarks or 
registered trademarks of Sony Corporation. HDV is a trademark of Sony Corporation and Victor Company of Japan, Limited (JVC). 
3GPP is a trademark of European Telecommunications Standards Institute (ETSI) This program includes software developed by the 
OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/) Open SSL is copyright (C) 1998-2005 The OpenSSL 
Project. All rights reserved. This program includes cryptographic software written by Eric Young (eay@cryptsoft.com). This program 
includes software written by Tim Hudson (tjh@cryptsoft.com). Cryptographic software inside Open SSL is copyright (C) 1995-1998 
Eric Young (eay@cryptsoft.com). All rights reserved. Adobe, Acrobat, Reader, Premiere, AIR, and Flash are trademarks or regis-
tered trademarks of Adobe Systems, Incorporated. AMD Athlon, AMD Opteron, AMD Sempron, AMD Turion, AMD App Acceleration, 
ATI Catalyst, ATI Radeon, ATI, Remote Wonder, and TV Wonder are trademarks or registered trademarks of Advanced Micro 
Devices, Inc. Linux is a registered trademark of Linus Torvalds. CompactFlash is a registered trademark of SanDisk Corporation. 
UPnP is a registered trademark of UPnP Implementers Corporation. Ask and Ask.com are registered trademarks of IAC Search & 
Media. IEEE is a registered trademark of The Institute of Electrical and Electronics Engineers, Inc. Philips is a registered trademark 
of Koninklijke Philips Electronics.N.V. InstallShield is a registered trademark of Macrovision Corporation. Unicode is a registered 
trademark of Unicode, Inc. Check Point is a registered trademark of Check Point Software Technologies Ltd. Labelflash is a trade-
mark of Yamaha Corporation. LightScribe is a registered trademark of the Hewlett-Packard Development Company, L.P. Intel, Intel 
Media SDK, Intel Core, Intel XScale and Pentium are trademarks or registered trademarks of Intel Corporation in the U.S. and/or 
other countries. MP3 SURROUND, MP3PRO and their logos are trademarks of Thomson S.A.  
Other product and brand names may be trademarks of their respective owners and do not imply affiliation with, sponsorship, or 
endorsement by owners.  
Nero AG reserves the right to change specifications without notice. Use of this product is subject to the acceptance of the End User 
License Agreement upon installation of the software. www.nero.com  
Nero AG, Im Stoeckmaedle 18, 76307 Karlsbad, Germany 



 

 
Nero Burning ROM 3 

Table of contents 
 
  

1 Start Successfully 6 
1.1 About the Manual 6 
1.2 About Nero Burning ROM 6 
1.3 Versions of Nero Burning ROM 7 
1.4 Working With the Program 7 

2 Starting the Program 8 

3 User Interface 9 
3.1 Main Screen 9 
3.2 New Compilation Window 11 
3.3 Selection Screen 16 

4 Data Disc 19 
4.1 Compiling Data Disc 19 
4.1.1 Defining Options 21 
4.2 Compiling a SecurDisc disc 24 
4.3 Nero DiscSpan (UDF) Compilation and Nero DiscMerge Tool 28 
4.3.1 Set Nero DiscSpan Options 29 
4.3.2 Creating Multiple Discs with Nero DiscSpan 29 
4.3.3 Remerge and Copy Data with Nero DiscMerge 32 
4.4 Check Point Media Encryption CD/DVD 34 
4.5 Saving Data Track 35 

5 Audio CD and Audio Files 37 
5.1 Compiling Audio CDs 37 
5.1.1 Customizing Properties of the Audio File 39 
5.1.2 Defining Options 43 
5.2 Mixed Mode CD and CD EXTRA 45 
5.2.1 CD-Extra Settings 46 
5.3 Automatic Music Recognition 46 
5.3.1 Identifying Audio Files 47 
5.4 Copy Audio CDs to Hard Drive 48 
5.4.1 Save Audio Tracks to Hard Drive Window 51 
5.5 Convert Audio File Format 54 
5.5.1 Encode Files Window 55 
5.5.2 AIFF and WAVE Encoding Options 56 
5.5.3 MP3 Lame Encoding Options 56 
5.5.4 MP3 and MP3PRO Encoding Options 58 
5.5.5 Nero AAC Encoding Options 60 
5.5.6 OGG Vorbis Encoding Options 61 

6 Video 62 
6.1 Compiling DVD-Video 62 



 

 
Nero Burning ROM 4 

6.2 Compiling an AVCHD Video Disc 63 
6.3 Compiling a BDMV-Video Disc 66 

7 Bootable Disc 68 
7.1 Requirements for Booting From a Disc 68 
7.2 Bootable Disc Template 68 
7.3 Creating and Burning a Bootable Disc 69 

8 Loading Image File 71 

9 LightScribe 73 
9.1 Printing LightScribe Label 73 
9.2 CD Label Editor Window 75 

10 Labelflash 77 
10.1 Burn Label Window 77 
10.2 Printing Labelflash Labels and DiskT@2 78 

11 Burn Compilation 81 
11.1 Choose Recorder Window 81 
11.2 Burn Settings 82 
11.3 Starting the Burn Process 85 
11.3.1 SecurDisc Surface Scan Results 87 
11.4 Burning With Image Recorder – Creating an Image File 89 

12 Copying a Disc 91 
12.1 Methods of Copying 91 
12.1.1 On-the-fly Copying 91 
12.1.2 Copy Over Image 91 
12.2 Copying Disc 92 
12.3 Copy Settings 94 
12.3.1 Image Settings 96 
12.3.2 Copy Options 97 
12.3.3 Read Options 98 

13 Erase Rewritable Disc Window 101 

14 About Nero SecurDisc Viewer 103 
14.1 Starting Nero SecurDisc Viewer 103 
14.2 Copying Data to Hard Drive 104 
14.3 Checking Data Integrity 104 
14.4 Checking Signature 105 

15 Nero MediaBrowser 107 

16 Configuration Options 110 
16.1 Compilation Settings 111 
16.2 Cache Settings 112 



 

 
Nero Burning ROM 5 

16.3 Expert Features 112 
16.4 Ultrabuffer Settings 113 
16.5 LightScribe Settings 114 

17 Technical Information 115 
17.1 System Requirements 115 

18 Glossary 116 

19 Index 120 

20 Contact 123 
  



Start Successfully 

 
Nero Burning ROM 6 

1 Start Successfully 

1.1 About the Manual 
This manual is intended for all users who want to learn how to use Nero Burning ROM. It is 
process-based and explains how to achieve a specific objective on a step-by-step basis. 

To make best use of this documentation, please note the following conventions: 

 
Indicates warnings, preconditions or instructions that have to be pre-
cisely followed. 

 Indicates additional information or advice. 

1. Start … The number at the beginning of a line indicates a prompt for action. 
Carry out these actions in the order specified. 

 Indicates an intermediate result. 

 Indicates a result. 

OK Indicates text passages or buttons that appear in the program inter-
face. They are shown in boldface. 

(see…) Indicates references to other chapters. They are executed as links and 
are shown in red and underlined. 

[…] Indicates keyboard shortcuts for entering commands. 
  

1.2 About Nero Burning ROM 
The powerful burning software Nero Burning ROM allows you to burn your data, music and 
videos to disc. Nero Burning ROM gives you full, customized control of your burning projects. 
You can − among other things − define the file system, the length of the file name and the 
character set; you can also change the disc label. And of course, you can also customize the 
Nero Burning ROM toolbar and change the keyboard shortcuts. 
Despite its wide range of features, Nero Burning ROM has remained an easy-to-use burning 
program that creates discs in just a few steps. You select the disc type to be burned 
(CD/DVD/Blu-ray), define the project type, add the required data and then start burning. 
Using Nero Burning ROM you can save audio files from an Audio CD to the hard drive. In the 
process, the files are encoded, i.e. converted into a format that the computer can read. The 
Audio CD can be automatically identified with Gracenote. So called metadata such as title, 
genre, and track title are accessed by the Gracenote Media Database and associated to the 
tracks. That way you have audio files that are accurately and fully named after the encoding 
process. 
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Music recognition technology and related data are provided by Gracenote®. Gra-
cenote is the industry standard in music recognition technology and related con-
tent delivery. For more information, please visit www.gracenote.com. 

1.3 Versions of Nero Burning ROM 
Nero Burning ROM is available as part of Nero 11 and as a standalone product.  
Both versions offer the full range of functions, but Nero Burning ROM as standalone product 
does not offer access to Nero MediaBrowser unless Nero Kwik Media is installed. 
You can always upgrade your standalone version to Nero 11 at www.nero.com. 

1.4 Working With the Program 
The main function of Nero Burning ROM is to select files and folders and to burn them to a 
disc. This is done in three basic steps: 

 

  In the New Compilation window, select a disc type and the disc format and set the op-
tions on the tabs. 

  In the selection screen, select files that you want to burn. 
  Start the burn process. 

See also 
  Main Screen →9 
  Compiling Data Disc →19 
  Compiling Audio CDs →37 
  Mixed Mode CD and CD EXTRA →45 
  Compiling DVD-Video →62 

http://www.gracenote.com/�
http://www.nero.com/�
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2 Starting the Program 
To start Nero Burning ROM, proceed as follows: 

 1. If you have the desktop shortcut available: 

 1. Click the  Nero Burning ROM desktop icon. 

 2. If you want to start via the start menu:  

 1. Select Start (the start icon) > (All) Programs > Nero > Nero 11 > Nero Burning ROM. 
 

 

It is also possible to start tasks with Nero Burning ROM from the context menu of 
a file or folder. 

 

 The Nero Burning ROM window is opened. 
 

 
Additionally, Nero Burning ROM can be started from the Welcome Application. 

 

  You have started Nero Burning ROM. 
 

 

At first startup and if not disabled, a getting started screen is displayed. Here you 
will find information about the main use cases and links to tutorials, helps, the 
Nero Community and other interesting Internet sites by Nero. 
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3 User Interface 

3.1 Main Screen 
The main screen of Nero Burning ROM is the starting point for all actions. It consists of a 
menu bar and a toolbar with buttons and a drop-down menu. 

 
Main window with menu and toolbar 

The following menus are available: 

File 
Provides program facilities such as opening, saving, and closing. You can 
also open the setting options for the compilation, update the compilation, and 
define configuration options. 

Edit Provides editing facilities for the files in the selection screen such as cutting, 
copying, and deleting. You can also display the properties of a selected file. 

View Provides the option to customize the user interface and to refresh the file 
browser. 

Recorder 
Provides recorder facilities. You can select the recorder here, start the burn 
process, and erase a rewritable disc. You can also eject a disc and display 
disc information. 

Extras Provides the option to convert tracks into other formats and to save the songs 
on an Audio CD to the hard drive. 

Window Provides the option to alter the position of the compilation area and browser 
area. 

Help Provides help facilities such as opening the help, and shows information 
about the application. 
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The following configuration options are available in the tool bar of the main screen. 

 Opens the New Compilation window where you can set options for a burn or 
copy process. 

 Opens an existing compilation. 

 Saves the active compilation. 

 Cuts selected elements in the compilation (selection). 

 Copies selected elements of the compilation (selection). 

 Pastes a selection that was cut or copied beforehand. 

 

Starts Nero MediaBrowser, which you can use to easily find, view and access 
media files and add them to your project. 
Not available for video compilations (DVD-Video for example) as video struc-
tures are not supported by Nero MediaBrowser. 

 

Starts Nero CoverDesigner, which you can use to create labels and covers. 
Information about a current compilation such as title, number, and names of 
the files is incorporated into the document data. You will find further informa-
tion in the Nero CoverDesigner manual. 

 
Starts Nero Express. Nero Express is a wizard-driven application based on 
Nero Burning ROM. You will find further information in the Nero Express ma-
nual. 

 Starts the burn process by opening the Burn Compilation window containing 
the Burn tab. 

 Starts the copy process by opening the New Compilation window containing 
the Burn tab. 

 Displays information on the disc inserted, such as contents (if any) and ca-
pacity for instance. 

 Opens the selected drive. 

 Shows or hides the file browser. 

Recorder 
selection 

menu 
Displays available recorders. 
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 Opens the Choose recorder window where you select an available recorder 
for the burn process from a list. 

 

Opens the Burn Label window where you can create or load a label to print 
on the label or data side of a Labelflash DVD. 
This button is only available if a recorder that supports Labelflash is con-
nected. 

 

Launches Nero CoverDesigner to create or load a label to be printed on the 
label side of a LightScribe disc. 
This button is only available if a recorder that supports LightScribe is con-
nected. 

 Displays information on the program and version number. 

  

 

 

Access to Nero MediaBrowser and Nero Express is only provided by Nero Burn-
ing ROM as part of Nero 11. 

 

See also 
  New Compilation Window →11 
  Bootable Disc →68 
  LightScribe →73 
  Labelflash →77 
  Loading Image File →71 
  Erase Rewritable Disc Window →101 
  Configuration Options →110 



User Interface 

 
Nero Burning ROM 12 

3.2 New Compilation Window 
In the New Compilation window you can select the disc type and configure the options for 
the disc format. The window basically looks the same for all disc types. The only difference is 
the tabs that are available. When you start Nero Burning ROM, the New Compilation win-
dow opens automatically. If the window is not open, click the New button. The window con-
sists of a drop-down menu, a selection list, various tabs, and buttons.  

 
New Compilation window, CD-ROM disc type 

If the Image Recorder is not enabled, only those disc types supported by the physical re-
corder are displayed in the drop-down menu. If the recorder can only burn CDs, the drop-
down menu is grayed out. 
 

 

Using Nero Burning ROM you can create image files for disc types that the in-
stalled recorder cannot burn. You can enable this function via the File > Options 
> Expert Features menu, Enable all Nero supported disc types for the Image 
Recorder check box. The drop-down menu in the Compilation window then 
makes available all supported disc types. 
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The following entries are available in the selection list: 

Entry 
CD/DVD-ROM/Blu-ray 

(ISO) 

Creates a data disc, each file type can be burned. The burned 
data complies with the ISO 966 standard. 

Entry 
Audio CD 

Creates a standard Audio CD that can be played on all (audio) 
CD players at least. 

Entry 
Mixed Mode CD 

Creates a CD with data and audio files in a single session. 
Usually a data file is followed by one or more audio files for in-
stance (e.g. soundtrack for PC games).  
Older Audio CD players are often not capable of recognizing the 
data file and attempt to play it. 

Entry 
CD EXTRA 

Creates a multisession CD with audio and data files that are 
stored in two sessions. The first session contains the audio files 
and the second session the data.   
Common CD players play the first session as Audio CDs. The 
second session can only be used by PCs with a CD-ROM drive, 
it cannot be recognized by a normal CD player. 

Entry 
CD/DVD/Blu-ray Disc 

Copy 
Copies a source disc to a CD/DVD/Blu-ray Disc. 

Entry 
CD/DVD-ROM (Boot) 

Creates a bootable disc. 

Entry 
CD/DVD-ROM/Blu-ray 

(UDF) 

Creates a data disc; all file types can be burned. The burned 
data complies with the UDF standard. 
Additionally you can use the Nero DiscSpan feature to create a 
compilation to be burned on multiple discs. You can mix different 
disc types. This means you can also insert DVDs and Blu-ray 
Discs even if you started with a CD compilation. The data is 
distributed automatically among several discs.  

Entry 
CD/DVD-ROM 

(UDF/ISO) 

Creates a data disc; all file types can be burned. The burned 
data complies with the ISO and UDF standards. 

Entry 
DVD-Video 

Creates a DVD that delivers high-quality playback of video 
and/or picture files on DVD players.  
You can use Nero Burning ROM to burn a DVD if the DVD video 
title, i.e. a complete DVD folder structure including premastered 
files is already available. 
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Entry 
AVCHD (TM) video 

Creates an AVCHD video disc that delivers high-quality playback 
of camcorder video and/or picture files on DVD or Blu-ray play-
ers.  
You can use Nero Burning ROM to burn an AVCHD video disc if 
a complete AVCHD folder structure including premastered files 
is already available. 

Entry 
BDMV-Video 

Creates a Blu-ray Movie (BDMV) disc that delivers high-quality 
playback of video files on Blu-ray players. 
You can use Nero Burning ROM to burn a BDMV-Video disc if a 
complete BDMV folder structure including premastered files is 
already available. 

  

 

 

In Nero Burning ROM it is not possible to convert video files to DVD-Video, an 
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD 
video, or BDMV-Video is possible in Nero Video for example. Nero Video is in-
cluded in the full version of Nero 11. More information about Nero Video is availa-
ble on the Web site www.nero.com, and more information about video editing is 
available in the separate Nero Video manual. 

 

 

 

The actual disc formats that are available and the actual disc types (e.g. DVD) to 
which can be written depend on the selected recorder. 

 

 

 

You can find more information on Blu-ray support at 
www.nero.com/link.php?topic_id=416. 

 

 

 

A Jump List is provided by Nero Burning ROM under the Windows 7 operating 
system. Compilation types, e.g. Audio-CD, can be chosen directly from the Jump 
List. 

 

The following buttons are available: 

Button 
Nero Express 

Starts Nero Express. Nero Express is a wizard-driven application 
based on Nero Burning ROM.  
Only available in Nero Burning ROM as part of Nero 11. 

Button 
Open 

Opens a file browser where you can find and open a saved compila-
tion. You can also open an image file in order to burn a disc. 

Button 
New 

Creates the selected compilation and displays the selection screen 
where you can select the files for burning. 

Button 
Cancel 

Closes the New Compilation window. 

http://www.nero.com/�
http://www.nero.com/link.php?topic_id=416�
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You can set the options for the respective disc format on the tabs in the New Compilation 
window.  
 

 
Which tabs are available depends on the disc type that is selected. 

 

The following tabs are available: 

Tab 
Info 

Shows statistical information on the compilation. 

Tab 
Multisession 

Contains options for configuring multisession discs. 
This tab is only available if a burner is installed. 

Tab 
ISO 

Contains options for configuring the ISO file system. 

Tab 
UDF 

Contains options for configuring the UDF file system. 

Tab 
Label 

Defines the labels of the disc. 

Tab 
Dates 

Allows you to define the dates of the compilation and of the asso-
ciated files. You can also specify a validity period for the disc.  
You can access the data regardless of the validity period specified. 

Tab 
Misc 

Defines whether and which files are stored in the buffer memory. If 
you posses a Lightscribe recorder you can create the label here or 
select what is to be printed. For the CD-ROM (ISO) disc type, you 
can convert the code for an AVI video here to make it compatible 
with Xvid/MPEG -4 or DivX. 

We recommend that you only convert the code if you have expe-
rience with FourCC codes and AVI videos. 

Tab 
Audio CD 

Contains options for configuring audio files.  
You can also enter additional information about the CD. 

Tab 
CDA Options 

Defines the strategy used by Nero Burning ROM for handling CD-DA 
files from a source audio CD. 

Tab 
CD EXTRA 

Contains options for configuring albums. 
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Tab 
Nero DiscSpan 

Contains the option for splitting of files. 

Tab 
Boot 

Contains options for configuring a bootable disc. 

Tab 
Burn 

Contains options for configuring burning. 

  

See also 
  Compiling Data Disc →19 
  Compiling Audio CDs →37 
  Mixed Mode CD and CD EXTRA →45 
  Compiling DVD-Video →62 

3.3 Selection Screen 
The selection screen is displayed in the main screen after you select the disc type and for-
mat in the New Compilation window and click the New button. The selection screen con-
sists mainly of the compilation area and the browser area. Essentially, all selection screens 
have the same structure. 

 
Selection Screen 

The compilation area (Disc Content) is located on the left side of the screen, and is named 
after the relevant compilation. Files and folders are compiled here for burning. In the browser 
area (File Browser) on the right side you can find the elements that you want to burn.  
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You can add data to your projects using the drag and drop function: Drag and drop the ele-
ments from the File Browser area to the Disc Content area. 
 

 
If the Browser area is hidden, you can show it again using the  button. 

 

The following setting options are available: 

Disc type drop-down 
menu 

Allows you to select another disc type without loss of informa-
tion. The option to change the disc type is useful when starting a 
compilation without knowing how much space is required by the 
files. 
Available for data compilations only. 

Selection list 
DVD9 (8.5 GB) /  
DVD5 (4.7 GB) 

Allows you to expand or shrink the capacity bar according to the 
type of DVD you are going to burn. Choose the DVD9 (8.5 GB) 
option for a double layer DVD (DVD DL) and DVD5 (4.7 GB) for 
a single layer DVD. 
Available for all DVD compilations. 

Selection list 
BD QL (BDXL) (128 GB) 

/  
BD TL (BDXL) (100 GB)  

BD DL (50 GB) /  
BD (25 GB) 

Allows you to expand or shrink the capacity bar according to the 
type of Blu-ray Disc you are going to burn: 
BD QL (BDXL) (128 GB) for a quadruple layer Blu-ray Disc,  
BD TL (BDXL) (100 GB) for a triple layer Blu-ray Disc,  
BD DL (50 GB) for a double layer Blu-ray Disc (BD DL) and 
BD (25 GB) for a single layer Blu-ray Disc. 
Available for all Blu-ray Disc compilations except BDMV-Video. 

Button 
Burn Now 

Starts the burn process immediately. If you want to check or 
select the burn or compilation options again before burning, click 
the Burn button in the upper part of the screen. 

  

The bottom margin of the screen contains a capacity scale in MB or GB for data discs or 
minutes (min) for Audio CDs. The exact size of the scale will depend on which disc type you 
have selected.  
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Actual capacity of media formats 
The actual capacity of the DVD5, DVD9, BD DL, and BDXL media formats is less 
than as stated by the disc manufacturers. For example, the actual capacity of a 
4.7 GB DVD5 is around 4.38 GB only.  
This is because of different conversion systems. A DVD5-media format can han-
dle 4.700.000.000 bytes, but this number is not equal to the 4.7 GB stated by the 
disc manufacturers. The correct conversion factor for bytes is not 1000, but 1024:  
1024 byte = 1 KB  
1024 KB * 1024 KB = 1 MB  
1024 KB * 1024 KB * 1024 KB = 1 GB  
A DVD can handle 4.700.000.000 bytes:  
4.700.000.000 bytes = 4.589.843 KB = 4.482 MB = 4.377 GB 
The capacity bar in Nero Burning ROM will always show you the correct amount 
of bytes measured in MB or GB. 

 

When you are compiling files, a capacity bar shows you the estimated size of the selected 
files and the available space on the disc. The color of the capacity bar indicates whether the 
data will fit on the disc or not: 

Green capacity bar The data will fit on the disc. 

Yellow capacity bar The data might fit on the disc. The size of the disc that has been 
inserted will determine whether the data will fit or not. 

Red capacity bar 
The data will not fit on the disc.  
(Unless you have inserted an oversize disc.) 

  

The yellow and red marks are set by default for discs that are commercially available. The 
disc type you have selected will determine the exact scale value. 
 

 

Capacity of the CD recordable disc 
For example, blank CDs are available with a capacity of 650 MB (74 min) or 700 
MB (80 min). Therefore, the yellow mark is set for CDs at 650 MB and the red at 
700 MB. 

 

 

 

Display the Capacity Bar 
If the capacity scale is hidden you can display it again by clicking the File > Op-
tions > Compilation menu and by selecting the check box Show the compila-
tion size in the Nero status bar. 
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4 Data Disc 

4.1 Compiling Data Disc 
With Nero Burning ROM you can compile and burn all types of files and folders. If a Blu-ray 
recorder is installed on your computer you can burn data CDs, data DVDs and data Blu-ray 
Discs. If you have a CD recorder you can only burn data CDs. The procedure for all data 
compilation methods is identical. 
 

 

The Image Recorder is also suitable for creating an image of a disc type not sup-
ported by the connected recorder. For example, you can therefore create a DVD 
image without having installed a DVD recorder. You can then write the image to a 
disc at any time. 

 

To create a data disc, proceed as follows: 

 1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New 
Compilation window. (In the case that the New Compilation window is not opened, it can 
be opened by clicking the New button on the main screen.) 
 The selection list shows the compilation types that can be burned. 

 
New Compilation Window 
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You can select an appropriate disc format without loss of information at any time 
in the main screen. Note that this has to be technically possible - for example you 
are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD 
and change later to a data DVD, for example. The possibility to change the disc 
type is useful when starting a compilation without knowing how much space is 
required by the files. 

 

 2. Select the desired compilation type for a data disc from the selection list (CD/DVD-
ROM/Blu-ray Disc (ISO), CD/DVD-ROM/Blu-ray Disc (UDF), or CD/DVD-ROM/Blu-ray 
Disc (UDF/ISO). 
 The tabs with the configuration options that are valid for this compilation type are dis-

played. 

 3. Set the options you require on the tabs. 

 4. Click the New button. 
 The New Compilation window is closed and the selection screen is displayed. 

 
Compilation screen 

 5. Select the files/folders that you want to burn from the File Browser area.  

 6. Drag the required files/folders into the Disc Content area on the left side. 

 The files are added to the compilation and displayed in the compilation screen. The ca-
pacity bar indicates how much space is required on the disc. 

 

 

In Nero Burning ROM, there is the option of defining filters for individual files or 
folders by dragging files or folders into the compilation areas with the depressed 
right mouse button. For instance, it is possible to filter for a particular type of file 
(*.doc, *.xls, *.txt) or select which type of file is not to be taken up in the compila-
tion area. 
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It is very easy to hide files in data compilations for additional protection or for se-
curity reasons so that they do not appear on the normal display. The files behave 
in the same way as other hidden system files that are hidden by default, but can 
easily be displayed. To hide files, right-click the required file, select the Proper-
ties option and then select the Hide check box. 

 

 

 

Nero Burning ROM supports virtual search folders in the Windows Vista operating 
system. The search is selected by dragging the search folder into the compilation 
area. If you want to select the files of the search folder, you must open the search 
folder and drag the files into the compilation. 

 

 7. Repeat the previous step for all files that you want to add. 
  You have successfully compiled a data disc and can now burn this compilation. 

See also 
  Selection Screen →16 

4.1.1 Defining Options 

4.1.1.1 Multisession Settings 
The Multisession tab provides the option to create multisession discs for data discs. Multi-
session discs can be burned in multiple sessions until you have reached the maximum disc 
capacity. A session is a self-contained data area that is burned using a single process, and 
consists of a lead-in (with the table of contents), one or more tracks, and a lead-out. Discs 
without the multisession option, e.g. Audio CDs, are burned in a single session. 
If a new multisession disc is being started, Nero Burning ROM also saves (if possible) the 
point of origin for the files. This information is used when continuing the multisession disc.  
If a multisession disc is being continued, Nero Burning ROM automatically sets a cross ref-
erence to the imported session, i.e. the table of contents for the imported session is copied 
to the table of contents for the current session. You must define which session is being im-
ported at the start of the burn process. The files in the previous sessions are retained and 
continue to take up space. 
In this case Nero Burning ROM automatically verifies whether the correct multisession disc 
has been inserted for continuation. If not, the disc is ejected. 
 

 

If you disable the Finalize disc check box on the Burn tab, you can always burn 
additional sessions on the disc, but then only the last session will be visible and 
you will only be able to access data from the last session. 

 

 

 

Multisession disc  
Multisession discs are particularly suitable for backing up important files burned 
on a regular basis.  
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Multisession Tab 

The following configuration options are available on the Multisession tab in the Multises-
sion area: 

Option button 
Start Multisession disc 

Burns the selected compilation in one session to the disc. 
If the disc already contains sessions, you can also select this 
option. Sessions are then not imported and cross references are 
not set. This means that only the last session will be visible and 
you will only be able to access data from the last session. 

Option button 
Continue Multisession 

disc 

Continues a multisession disc by burning an additional session 
to a disc with at least one session. Cross references to the im-
ported session are set in the process. 

Option button 
No Multisession 

Creates a disc without a multisession.  
However, even a disc without a multisession can be continued 
as long as it is not fixated. Sessions are then not imported and 
cross references are not set. This means that only the last ses-
sion will be visible and you will only be able to access data from 
the last session.  

  

 



Data Disc 

 
Nero Burning ROM 23 

4.1.1.2 ISO Settings 
The ISO tab provides options for configuring the ISO file system. 
ISO 9660 is a system-independent standard. It can be read on all operating systems. The 
following features apply: 

 

  Permits eight characters plus three characters for the file extension (Level 1) or 31 cha-
racters (Level 2) for the file name including the file extension. 

  Permits eight characters for the folder name. 
  Restricts the maximum directory depth to eight levels (including root folder). 
  The characters A-Z, 0-9 and the underscore (_) are permitted. 
In the ISO tab, in the area Relax Restriction, the restrictions imposed by the selected file 
system can be relaxed. For example, you can allow a higher path level or more than 64 cha-
racters for the Joliet name. 
 

 

If the disc should be read on all operating systems, select ISO 9660 as the file 
system and clear all check boxes in the Relax restrictions area. 

 

 

 

An advisory message appears on the ISO tab in the Information area if the disc 
cannot be read on all operating systems. 

 

 

 

If the disc is to be used mainly on computers with Microsoft Windows and you 
want to use lowercase letters and/or foreign language characters for the file 
names, select ISO 9660 + Joliet as the file system. 

 

The following setting options are available on the ISO tab in the Data and File areas: 

Drop-down menu 
Data mode 

Selects the mode for the data. Mode 1 and Mode 2/XA are 
available. Newer drives can easily read Mode 1 and Mode 2/XA 
CDs. 
However, some older drives cannot read Mode 1 discs correctly. 
In the case that the disc can to be read in any case on older 
drives, select the Mode 2/XA format. 

Drop-down menu 
File system 

Selects the file system that is used for the data. 
ISO 9660 only: ISO format alone is used.  
ISO 9660 + Joliet: ISO format is used and is enhanced by the 
Joliet standard. 
ISO 9660:1999: The latest ISO format update is used. Among 
other things it allows the use of 207 characters and a deeper 
directory depth. 
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Drop-down menu 
Length of file name 

Defines the possible length of the file name. Level 1 and Level 
2 are available. In Level 1 the file name can be eight characters 
long and the file name extension (e.g. *.doc) three characters. In 
Level 2 the file name can be 31 characters long. 

Drop-down menu 
Character set 

Defines the character set used for ISO names. 

  

 

4.1.1.3 UDF Settings 
The UDF tab provides options for configuring the UDF (Universal Disc Format) file system. 
The UDF standard was developed by Osta (Optical Storage Technology Association) in re-
sponse to the requirements of DVDs. The standard works on all platforms. 

The following setting options are available in the Options drop-down menu: 

Entry 
Automatic Settings 

Sets options automatically for the UDF file system. 
We recommend that you select this entry. 

Entry 
Manual Settings 

Enables you to manually define the UDF partition type and the 
file system version. 

Entry 
Enable Xbox compati-

bility mode 

Creates a disc that is compatible with an Xbox.  
This entry is available if the No Multisession option button is 
selected on the Multisession tab. 

  

 

 
A disc that is compatible with Xbox cannot be created as a multisession disc. 

 

4.2 Compiling a SecurDisc disc 
SecurDisc is a technology with which you can create discs with special protection properties. 
No special hardware is needed. 
Discs that are created with Nero Burning ROM and the SecurDisc compilation type include 
data integrity and reconstruction. Additional SecurDisc features include the possibility to 
protect the data on your disc against unauthorized access with a password, to digitally sign 
the disc, and to configure the data redundancy. 
To be able to copy the protected data to your hard drive and to check the security of the data 
you will need a special application named Nero SecurDisc Viewer. The Nero SecurDisc 
Viewer is burned automatically to the SecurDisc disc and can be downloaded free of charge 
at www.securdisc.net or www.nero.com. 
 

http://www.securdisc.net/�
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More information on SecurDisc technology can be found at www.securdisc.net. 

 

To compile a SecurDisc disc, proceed as follows: 

 1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New 
Compilation window. (In the case that the New Compilation window is not opened, it can 
be opened by clicking the New button on the main screen.)  
 The selection list shows the compilation types that can be burned. 

 2. Select the desired compilation type for a SecurDisc from the selection list. 
 The tabs with the configuration options that are valid for this compilation type are dis-

played. 

 
SecurDisc Compilation 

 3. If you want to enable the password protection for all files: 

 1. Enable the Password protection check box on the SecurDisc tab. 
  The SecurDisc – Protect Data window is opened. 

http://www.securdisc.net/�
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 2. Enter the desired password in the Password input area and then click the OK button. 

 

When appropriate, a wizard offers suggestions in an additional Tips dialog box 
when entering and selecting the password. The wizard estimates the security 
level, i.e. the quality of the password, during entry. 

 

 4. If you want to sign the disc with a digital signature: 

 1. Select the Digital signature check box on the SecurDisc tab. 
  The SecurDisc – Digital Signature window is opened. 
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 2. If you have already created a digital key, click the Browse button and select the key. 
 3. If you want to create a digital key, click the Start button. 

  The SecurDisc – Create Digital Key window is opened. 
 4. Read the instructions and click the Next button. 

  The SecurDisc Key Creation Process window is opened. 
 5. Move your mouse at random until the creation process is complete. 

  Nero Burning ROM uses the random data to create the SecurDisc key. You can moni-
tor the status of the creation process using the progress bar. The Next button is 
enabled as soon as the process is complete. 

 6. Click the Next button.  
  The SecurDisc – Key Creation Completed window is opened. 

 7. Enter a file name for the key you have created and click the Finish button. 
  The SecurDisc – Digital Signature window is opened again and the selected key 

appears in the drop-down menu. 
 8. Click the OK button. 

  The corresponding window is opened to inform you that the disc is being digitally 
signed with the selected key. 

 9. Click the OK button. 
 

 

You can pass on the relevant public key to recipients to enable them to verify the 
signature. 

 

 5. If you want to enhance the burning speed by limiting the data redundancy or to configure the 
data redundancy:  

 1. Select the Data redundancy check box on the SecurDisc tab.  
  The drop-down menu is enabled. 

 2. Select the desired redundancy level. 
 

 

If the Data redundancy check box is disabled, the disc will be filled completely 
with copies of the chosen data and checksums. A display panel in the compilation 
screen indicates the current redundancy level. 

 

 

 

A redundancy level of 1,3 means no redundancy and a redundancy level of 9 
means excellent redundancy. 
We recommend a redundancy level of at least 2,5. 

 

 6. Click the New button.  
 The New Compilation window is closed and the selection screen is displayed. 
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SecurDisc Selection Screen 

 7. Select the files/folders that you want to burn from the File Browser area.  

 8. Drag the required files/folders into the Disc Content area on the left side. 
 The files are added to the compilation and displayed in the compilation screen. The ca-

pacity bar indicates how much space is required on the disc. 
 

 

You can selectively enable the password protection for individual files by marking 
the desired file in the compilation screen and clicking the Protect button. 

 

 9. Repeat the previous step for all files that you want to add. 
  You have compiled a SecurDisc disc with settings according to your requirements 

and can now burn the disc. 

See also 
  About Nero SecurDisc Viewer →103 

4.3 Nero DiscSpan (UDF) Compilation and Nero DiscMerge Tool 
With Nero Burning ROM you can compile and burn all types of files and folders to multiple 
discs. The Nero DiscSpan feature for UDF compilation type is useful when the data to be 
burned is too large to fit on a single disc or when a single file exceeds the capacity of a disc. 
Nero Burning ROM can split such files automatically and distributes them dynamically 
among several discs. 
The number of discs to be used is shown in the compilation screen and you can switch the 
disc type here. However, during the burn process you are allowed to alternate the disc types 
(CD, DVD, Blu-ray Disc) regardless of which disc type you chose at the beginning. 
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The restore tool Nero DiscMerge and a file catalog is burned on the last disc of the set by 
Nero Burning ROM. With this tool the split files can be merged together and copied to the 
hard drive. Files that are not split can of course be accessed without the help of Nero Dis-
cMerge. 

4.3.1 Set Nero DiscSpan Options 
The Nero DiscSpan tab provides configuration options for the Nero DiscSpan feature. 

The following configuration options are available: 

Check box 
Enable Nero DiscSpan 

Enables the Nero DiscSpan feature. The compilation is burned 
to multiple discs, if necessary. 
Nero DiscSpan can only be enabled, if on the Multisession tab 
the No Multisession option button is selected. 

Option button / Input field 
Allow the splitting of 
files which exceed 

Enables the option that files that exceed a certain file size are 
split if this is necessary to fill up a disc space. The original order 
of the files is being kept. 
Note, that you need Nero DiscMerge in order to merge split files 
and folders. Nero DiscMerge is automatically burned to the last 
disc. 

Option button 
Allow Nero DiscSpan 
without file splitting 

Enables the option that files are not split. 
Note, that the file size is therefore limited by the disc size at 
least. 

Check box 
Add Nero DiscMerge 

and file catalog to mas-
ter disc 

Adds Nero DiscMerge to the last disc. Nero DiscMerge is used 
to merge split files. It is automatically burned to the last disc if 
the Allow the splitting of files option is enabled. 

  

4.3.2 Creating Multiple Discs with Nero DiscSpan 
With Nero Burning ROM you can compile and burn all types of files and folders to multiple 
discs. Files that exceed a certain file size are split if this is necessary to fill up a disc space. 
The original order of the files is being kept. 
The number of discs to be used is shown in the compilation screen and you can switch the 
disc type here. 
 

 

The Image Recorder is also suitable for creating an image of a disc type not sup-
ported by the connected recorder. For example, you can therefore create a DVD 
image without having installed a DVD recorder. You can then write the image to a 
disc at any time. 
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To create an UDF compilation using the Nero DiscSpan feature, proceed as follows: 

 1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New 
Compilation window. (In case that the New Compilation window is not opened, it can be 
opened by clicking the New button on the main screen.) 
 The selection list shows the compilation types that can be burned. 
 

 

You can select an appropriate disc format without loss of information at any time 
in the main screen. Note that this has to be technically possible - for example you 
are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD 
and change later to a data DVD, for example. The possibility to change the disc 
type is useful when starting a compilation without knowing how much space is 
required by the files. 

 

 2. Select an UDF compilation type from the selection list. 
 The tabs with the configuration options that are valid for this compilation type are dis-

played.  

 3. Click the Nero DiscSpan tab. 
 The Nero DiscSpan tab is displayed. 

 
New Compilation - DiscSpan (UDF) 

 4. Select the Enable Nero DiscSpan check box. Make sure, that on the Multisession tab the 
No Multisession option button is selected. 
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Discs that use the Nero DiscSpan feature cannot be created as multisession 
discs. 

 

 5. Set the desired options on the tabs. 

 6. Click the New button. 

 The New Compilation window is closed and the selection screen is displayed. 

 
Selection Screen - DiscSpan (UDF) 

 7. Select the files/folders that you want to burn from the File Browser area. 

 8. Drag the required files/folders into the Disc Content area on the left side. 
 The files are added to the compilation and displayed in the compilation screen. The ca-

pacity bar indicates how much space is required by the DiscSpan compilation. On the 
left an info field indicates how much discs will be burned. 

 

 

In Nero Burning ROM, there is the option of defining filters for individual files or 
folders by dragging files or folders into the compilation areas with the depressed 
right mouse button. For instance, it is possible to filter for a particular type of file 
(*.doc, *.xls, *.txt) or select which type of file is not to be taken up in the compila-
tion area. 

 

 

 

It is very easy to hide files in data compilations for additional protection or for se-
curity reasons so that they do not appear on the normal display. The files behave 
in the same way as other hidden system files that are hidden by default, but can 
easily be displayed. To hide files, right-click the required file, select the Proper-
ties option and then select the Hide check box. 
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 9. If required, you can change the disc type. 
  You have successfully compiled a data disc and can now burn this compilation. Dur-

ing the burn process you will be prompted to insert a new disc whenever needed. 
You are allowed to alternate the disc types (CD, DVD, Blu-ray Disc) regardless of 
which disc type you chose at the beginning. Files will be distributed dynamically 
among several discs. 

4.3.3 Remerge and Copy Data with Nero DiscMerge 
With Nero DiscMerge you can merge split files and folders that had been burned on multiple 
discs using the Nero DiscSpan feature for UDF compilation type. The content of the discs is 
copied on the hard drive during this process. You can exclude individual files from the copy 
process or select specific files to be copied. 
The tool Nero DiscMerge was burned on the last disc of the set - the so called Master Disc - 
by Nero Burning ROM. 

 

Under Windows Vista and Windows 7 you need administrator rights to save the 
files to secure folders such as C:\Program files. Therefore, a User Account Con-
trol message asking for administrator rights may appear with these operating 
systems. 

 

To restore the data of DiscSpan discs, proceed as follows: 

 1. Insert the Master Disc - the last burned disc - into a drive. 

 Nero DiscMerge starts automatically. The content, i.e. folder structure and files, of the 
DiscSpan disc set is displayed. 

 
Nero DiscMerge 
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If the program does not start automatically, select the drive with the disc in Win-
dows Explorer. You can start Nero DiscMerge manually by double-clicking the 
NeroDiscMerge.exe file in the $Nero$ folder. 

 

 2. Select the copy target in the Target path input field by clicking the Browse button. 

 3. Select the check box preceding the folder or the file that you want to copy. Select a folder in 
the left to show the contained files in the right. 

 4. Click the Copy Data button. 
 The Copy Status window is opened. 
 A message window is opened prompting for the first burned disc. 

 5. Remove the current disc and insert the first burned disc into the drive. 
 The message window is closed and the copy process is started. Split files are merged 

together. Information about the current step is displayed in the information area. A 
process bar indicates the progress being made. When the content of this disc is com-
pletely copied, then the disc is ejected. The message window is opened again prompting 
for the next disc. 

 
Copy Status 

 6. Insert each disc of the set in chronological burning order. 
 Once the copy and merging process is complete, the message "Disc merging complete" 

is displayed in the information area. The Cancel button changes to Close. 
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Copy Status - complete 

 7. Click the Close button. 

 The Copy Status window is closed. 

 8. Click the Close button. 

 Nero DiscMerge is closed. 
  You have successfully copied the content of multiple DiscSpan discs to your hard 

drive. 

4.4 Check Point Media Encryption CD/DVD 
With Nero Burning ROM and Check Point Media Encryption you can create discs with spe-
cial encryption security protection. 
 

 

This feature is only available if all of the following requirements are fulfilled: 
(1) Check Point Endpoint Security Media Encryption, version R73 or later, is in-
stalled on your computer. 
(2) You are allowed to create Check Point Media Encryption CD/DVDs. 
(3) You have a special serial number. 

 

The procedure for compiling and burning a Check Point Media Encryption disc is basically 
the same as the procedure for compiling and burning data discs. Be sure to select the 
CD/DVD-ROM (Check Point) entry in the New Compilation window. 
When starting the burn process, a window, which originates from Check Point Media Encryp-
tion, will be opened. After entering security information, e.g. a password for encryption as 
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defined in your Check Point Media Encryption settings, Check Point Media Encryption then 
encrypts the data. When the encryption is finished, the window is closed and Nero Burning 
ROM continues the burn process. Depending on your Check Point Media Encryption set-
tings, a decryption tool is burned on the disc, allowing another user, who does not have 
Check Point Media Encryption, to access to the data by entering the password. 
 

 

The encryption of the data does not take place in Nero Burning ROM. Nero AG is 
not responsible for the data encryption and the decryption tool. These features 
are provided by Check Point Software Technologies. 

 

4.5 Saving Data Track 
With Nero Burning ROM you can save a data disc as an image file. The image file can later 
be burned to a recordable disc. The result is a copy of the original data disc. 
To save the data disc as an image file, proceed as follows: 

 1. Insert the data disc in a drive. 

 2. Click the Extras > Save Data Tracks menu. 
 The Select Track window is opened. The tracklist shows you the sessions and data 

tracks that are found on the disc. Due to the technical reasons, only the first data track of 
the first session can be saved. 

 
Select Track 

 3. Select the first data track. 

 4. Click the Save Track button. 
 The Save As window is opened. 
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 5. Select a file name and a storage location. 

 6. In the Save As drop-down menu, select the desired output format (ISO or NRG) for the 
image file. 

 7. Click the Start button. 
 The Progress window is opened and displays the progress made while saving. When 

the save process is complete, the window is closed automatically. 
  You have successfully created an image file starting from a data disc. Now you can 

burn the image file to a disc. 
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5 Audio CD and Audio Files 

5.1 Compiling Audio CDs 
Using Nero Burning ROM you can create an Audio CD that contains music files. It can be 
played on all standard CD players. To compile an Audio CD, source files with different audio 
formats are automatically converted into Audio CD format before being burned. 
 

 
Some CD players cannot play CD-RWs. Use CD-R discs to burn Audio CDs. 

 

To create an Audio CD, proceed as follows: 

 1. Select the CD entry from the drop-down menu in the New Compilation window. (In the 
case that the New Compilation window is not opened, it can be opened by clicking the 
New button on the main screen.) 

 2. Select the Audio CD compilation type from the selection list. 

 The tabs with the configuration options that are valid for this compilation type are dis-
played. 

 
Audio CD 
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 3. Set the desired options on the tabs. 
 

 

Audio CDs should always be burned using the disc-at-once method. This entry is 
selected by default. 

 

 4. Click the New button. 
 The New Compilation window is closed and the selection screen is displayed. 

 5. Select the audio files that you want to burn from the File Browser area on the right side. 
You can use the hard drive or an Audio CD as source of the audio file. 

 

 
You can also choose an M3U playlist as a source. 

 

 6. Drag the desired audio files into the Disc Content area on the left side. 
 The files are added to the compilation and displayed in the compilation screen. The ca-

pacity bar indicates how much space is required on the disc. 

 
Compilation screen - Audio CD 

 7. Repeat the previous step for all audio files that you want to add. 

 8. Customize the properties of the audio file to suit your requirements. 
  You have successfully compiled an Audio CD and can now burn this compilation. 

See also 
  Selection Screen →16 
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5.1.1 Customizing Properties of the Audio File 
You can display and/or make changes to the audio file properties on the Track Properties, 
Indexes, Limits, Splits and Filters tabs of the Audio Track Properties window. To open 
the window, mark an audio file in the compilation screen for Audio CDs and click the Proper-
ties button. 

5.1.1.1 Track Properties Tab 
On the Track Properties tab you will find basic information on the selected file in the 
Source information area. To open the window, mark an audio file in the compilation screen 
for Audio CDs and click the Properties button.  

 
Track properties 

The following input areas are available in the Properties area: 

Input field 
Title (CD Text) 

Defines a title which is saved as CD Text. CD players that support 
CD Text show the title name entered here. 
Only Latin characters can be displayed as CD Text. CD Text can 
only be written in disc-at-once mode. 

Input field 
Artist (CD Text) 

Defines the artist which is saved as CD Text. CD players that sup-
port CD Text show the artist's name entered here. 
Only Latin characters can be displayed as CD Text. CD Text can 
only be written in Disc-At-Once mode. 
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Input field 
Pause 

Defines the length of the pause in seconds or frames between the 
selected audio file and the next one. 

Input field 
International Stan-

dard Recording 
Code (ISRC) 

Identifies the CD title using a 12-character digital code. The ISRC is 
entered in the subcode and included silently. 
If you do not know the ISRC, you should leave this input field blank.  

Check box 
Protection 

Sets the copy protection bit for the corresponding track on the Audio 
CD. As most CD recording applications simply ignore this bit, copy 
protection cannot be ensured. A warning message will be opened in 
Nero Burning ROM while copying an Audio CD with copy protected 
tracks. 

Check box 
Cross fade with 
previous track 

Defines a crossfade between this and the previous audio file. You 
can specify the length of the crossfade in seconds or in sectors.  

  

5.1.1.2 Indexes, Limits, Split Tab 
On the Indexes, Limits, Split tab you can set and delete indexes and split audio files to 
create two or more shorter ones. The tab consists of the Oscilloscope and Positions areas. 

 
Indexes, Limits, Split Tab 
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Audio files are displayed graphically in the Oscilloscope area. The following configuration 
options are available in the Positions area: 

Selection lists 
Start/End 

Shows the positions for the beginning and end of the audio file on 
the CD. 

Button 
New Index 

Sets a new index position at the selected position. For the CD player 
this is the position from which a new song starts, and the player can 
also jump to it directly. However, not all CD players support this fea-
ture. 

Button 
Edit 

Opens the Edit track limit dialog box. 
You can enter the exact position of a split. 

Button 
Delete 

Deletes a selected index. 

Button 
Split 

Splits the audio file at the marked position. 

Button 
Play 

Plays the audio file from the marked position.  
During playback, the Stop playing button is displayed. 

Button 
Stop playing 

Stops playback of the audio file.  
If playback is stopped, the Play button is displayed again. 

Button 
Split at Index Posi-

tions 
Splits the audio file at the set index positions. 

Button 
Zoom In 

Enlarges the graphical representation of the audio file. 

Button 
Zoom Out 

Reduces the graphical representation of the audio file. 

Button 
Full View 

Displays a graphical representation of the entire audio file. 

  

5.1.1.3 Filters Tab 
The Filters tab includes filters that improve or change the quality of the music. The so-called 
non-destructive procedure is used for processing, i.e. the actual recording is not changed, 
but flags are simply set that can be canceled at any time. No additional audio data is 
created. The audio files on hard drive are not modified during this procedure. 
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Audio Track Properties window, Filters tab 

The following configuration options are available in the Audio Track Properties window: 

Check box 
Normalize 

Sets the volume of an audio file to a preset value. This filter can be 
useful to bring the volume of files originating from different sources 
into line with one another. 

Check box 
Declick 

Removes clicking and scratching noises, such as those on old LPs 
for example. 

Check box 
Hiss Reduction 

Reduces or removes the hiss on an audio file. All frequencies be-
low a certain threshold (hiss level) are removed. 

Check box 
Fade In 

Fades in the volume of an audio file from zero to full volume. This 
filter can be useful for shortening files. 

Check box 
Fade Out 

Fades out the volume of an audio file from full volume to silence. 
This filter can be useful for shortening files. 

Check box 
Stereo Widening 

Increases/reduces the stereo effect of an audio file. This filter only 
works if the original file was recorded in stereo. 

Check box 
Karaoke 

Fades out the vocals on an audio file. This is done by fading out 
the parts of a song that are the same in both stereo channels. 

Check box 
Echo 

Adds an echo to the audio file. 
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Check box 
Equalizer 

Opens an equalizer so you can change the volume, bass, and 
pitch in different frequency ranges. 

Button 
Test Selected Filters 

Plays the audio file and applies the activated filters. During play-
back, the configuration options for the filters can be changed, al-
lowing the effect to be controlled. 

  

5.1.2 Defining Options 

5.1.2.1 Audio CD Settings 
The Audio CD tab provides options for setting the Audio CD. 

 
Audio CD Tab 

The following configuration options are available on the Audio CD tab in the General area: 

Check box 
Normalize all au-

dio files 

Enables a filter that brings the volume of the audio files to be burned 
into line with one another. This is particularly recommended if the 
audio files originate from different sources. 

Check box 
No pause between 

tracks 

Allows the audio files to merge into one another on the Audio CD 
without a pause (just like in live recordings).  
If the check box is cleared, there are pauses of two seconds between 
the audio files. 
We strongly recommend using the disc-at-once mode. Otherwise the 
zero pause length may not be supported by all recorders and/or a 
very short clicking noise may be heard between tracks. 
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The following configuration options are available in the CD Text area: 

Check box 
Write on CD 

Enables the option for writing CD Text. With CD players that 
support CD Text, the title of the CD, the name of the audio file as 
well as the name of the artist appear in the display. 
CD Text can only be written in disc-at-once mode. 

Input field 
Title 

Defines the label of the Audio CD. 

Input field 
Artist 

Defines the artist. 

  

You can also enter additional information about the Audio CD such as the producer or com-
ments. 

5.1.2.2 CDA Settings 
The CDA Options tab provides options for configuring CD-DA files on the Audio CD. The 
CDA file strategy area allows you to select the strategy that Nero Burning ROM should use 
for handling selected audio files from a source Audio CD. In general there are two methods: 

 

  Read the audio file and store it in the cache temporarily. The Audio CD can be burned in 
disc-at-once mode, which supports CD Text. 

  Create a reference to the audio file and read it shortly before burning (track reference). 
The Audio CD can only be burned in track-at-once mode. 

 

 

To add tracks from a source Audio CD to your audio compilation, we generally 
recommend the following alternative: 
Rip the source Audio CD to hard drive (see Copy Audio CD to Hard Drive→ 48). 
Ideally, save the tracks in the lossless FLAC format. Then proceed by adding the 
audio files to the audio compilation. 

 

The following setting options are available on the CDA Options tab in the CDA File Strate-
gy area: 

Drop down menu entry 
Diskspace strategy 

Saves the audio files temporarily to the Nero Burning ROM 
cache. 
If there is no space available, a reference is created to the audio 
file and is not read until shortly before burning. This entry is se-
lected by default. 

Drop-down menu entry 
Tempfile strategy 

Saves the audio files temporarily to the Nero Burning ROM 
cache. 
If there is no space available, an error message appears. 
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Drop-down menu entry 
Reference strategy 

Creates a reference to the audio file and reads it shortly before 
burning. The source medium can only be a CD/DVD drive, not a 
recorder. The disc can only be burned in track-at-once mode. 

Drop-down menu entry 
Device dependent 

strategy 

Creates a reference to the audio file if a CD/DVD drive is availa-
ble. Otherwise the tempfile strategy is used. 

  

The following setting options are available on the CDA Options tab in the Drive area: 

Selection list 
Drive 

Lists recognized drives and burners. 

Drop-down menu 
Read speed 

Selects the speed at which the CD is read. 

Check box 
Cache track on hard 
drive before burning 

Saves the audio file in the cache before burning. 

  

The following setting options are available on the CDA Options tab in the Advanced area: 

Check box 
Remove silence at the 

end of audio tracks 

Removes silence at the end of individual audio files, i.e. music 
tracks transition smoothly from one to the next. This check box is 
selected by default. 
To avoid unwanted effects set the pause length to 0 when clear-
ing this check box (to set the pause length see Track Properties 
Tab→ 39). 

  

5.2 Mixed Mode CD and CD EXTRA 
With Nero Burning ROM you can compile CDs that include both audio and data files. 
The following compilation methods are available: 
  Mixed Mode CD 
  CD EXTRA 
A Mixed Mode CD includes the data and the audio files in one session. CD EXTRA includes 
the audio files in the first session and the data files in the second session. 
The procedure for compiling the audio and data files is basically the same as the procedure 
for compiling data or music CDs. Please be sure to select the corresponding entry in the 
New Compilation window. The selection screen includes a compilation area for audio files 
and one for data files. The compilation can only be burned if files have been added to both 
the audio and the data compilation area. 

See also 
  Selection Screen →16 
  Compiling Audio CDs →37 
  Compiling Data Disc →19 
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5.2.1 CD-Extra Settings 
The CD EXTRA tab provides configuration options for albums. 

The following information is available in the Info area: 

Display panels Displays information on the compilation. 
  

The following configuration options are available in the Album area: 

Input field 
Album identification 

Defines a name for the album. This is particularly useful when 
the album is to comprise several CDs. 

Input field 
Number of volumes in 

album 
Defines the number of discs that the compilation should contain. 

Input field 
Album sequence num-

ber 
Defines the album number of the current disc. 

Button 
Pictures 

Opens the CD EXTRA Pictures window where you can select 
the pictures for the front and flipside of the CD and define the 
picture format. 

  

The following configuration options are available in the Localization area: 

Display panel 
Languages 

Displays available languages. When you select a language, you 
can add the title for the album in the Album title text box. Each 
language can contain a different title. 

Button 
Add 

Opens the New Language window where you can select a new 
language from a country list. 

Button 
Delete 

Deletes the selected language. 

Input field 
Album Title 

Adds an album title to the language highlighted in the Languag-
es selection list. 
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5.3 Automatic Music Recognition 
With Gracenote MusicID Nero Burning ROM can identify music files. So called metadata 
such as artist, title, and genre are accessed from the Gracenote Media Database and dis-
played in Nero Burning ROM. The identified metadata is written to the music file and is then 
available. 
Identification is possible for single audio files as well as complete original Audio CDs.  
If the metadata of the Audio CD is not yet included in the database then you can enter it and 
make it available. The metadata is sent to Gracenote and added into the database. 
With Gracenote you can have audio files identified out of any sort of audio compilation. This 
is particularly useful when audio files are not named or are only partially named. The meta-
data that is made available by Gracenote is used for the compilation and is written into the 
audio files. In this way your music collection is correctly tagged with all information. 
During the following actions, original Audio CDs can be automatically identified in Nero Burn-
ing ROM with Gracenote MusicID. 

 

  Copying Audio CD 
  Saving Tracks from the Audio CD to Hard Drive 
 

 

Music recognition technology and related data are provided by Gracenote®. Gra-
cenote is the industry standard in music recognition technology and related con-
tent delivery. For more information, please visit www.gracenote.com. 

 

5.3.1 Identifying Audio Files 
You can have the added audio files in the music compilations identified with Gracenote and 
access metadata such as artist and title from the Gracenote Media Database. 
To do this, proceed as follows: 

 1. Select the type of compilation to burn a music CD. 

 The compilation screen is displayed. 

 2. Add audio files from the hard drive to the music compilation. 

 3. Select one or more audio files in the compilation. 

 4. Right-click to open the context menu. 

 5. Select the Get metadata entry. 
 The audio files are analyzed and the required information is sent to Gracenote. The Edit 

Meta Data window is opened. The metadata received by Gracenote is displayed in the 
New Info area. 

http://www.gracenote.com/�
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Edit Meta Data window 

 6. If necessary, edit the metadata, e.g. track number, title, artist, album title, year, and genre. 

 7. Click the Apply button. 
 The Edit Meta Data window is closed. 

  The metadata is written into the audio file and accordingly shown in Nero Burning 
ROM. If the Adjust all file name(s) check box is selected, the file on hard drive is 
renamed accordingly (if technically possible). 

5.4 Copy Audio CDs to Hard Drive 
With Nero Burning ROM you can save audio files from an Audio CD to the hard drive. In the 
process, the files are encoded, i.e. converted into a format that the computer can read. The 
audio file is usually compressed. 
The Audio CD can be automatically identified with Gracenote MusicID. So called metadata 
such as title, genre, and track title are accessed by the Gracenote Media Database and as-
sociated to the tracks. If available, Album art is also displayed and associated to the tracks. 
That way you have audio files that are accurately and fully named after the encoding 
process. 
 

 

Music recognition technology and related data are provided by Gracenote®. Gra-
cenote is the industry standard in music recognition technology and related con-
tent delivery. For more information, please visit www.gracenote.com. 

http://www.gracenote.com/�
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Audio files from copy-protected Audio CDs cannot be saved. 

 

To save audio files, proceed as follows: 

 1. Click the Extras > Save Audio Tracks menu. 
 The Save Audio Tracks to Hard Drive window is opened. 

 2. Insert your Audio CD into a drive. 

 The disc is being analyzed and the required information is sent to Gracenote. If an ex-
actly matching metadata entry is found in the Gracenote Media Database then that me-
tadata entry will be used and displayed. 

 If several metadata entries are found or the found entry is ambiguous, then the Matches 
window is opened and the metadata etries in question are displayed. 

 3. Select the metadata entry that matches your Audio CD. 

 4. Click the Send New Data button if none of the metadata entries match your Audio CD. 
 The Edit MetaData window is opened. 

 
Edit MetaData 
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The Edit Meta Data window also opens if no matching entry is found in the data-
base but you want to enter the metadata and make it available. 

 

 5. Edit the audio track metadata (Title and Artist) by clicking in the track list. 

 6. Edit the Audio CD metadata (Album Title, Artist, Year, and Genre as well as Album Art) 
on the right side. 

 7. Click the Advanced Options button if you want to add additional information. 

 The Gracenote MusicID Information window, which originates from Gracenote, is 
opened. After entering the additional information you have to close this window so that 
the Edit MetaData window is displayed again. 

 8. Click the Submit Data button. 
 If you have changed the Audio CD's metadata or filled it in for the first time then the 

changes are sent to Gracenote and entered into the Gracenote Media Database. 
 The Edit MetaData window is closed and the information is passed on to the Save Au-

dio Tracks to Hard Drive window. 

 
Save Audio Tracks to Hard Drive 

 9. Select the tracks that you want to save on the hard drive. 
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 10. Click the Output tab. 

 The Output tab is opened. 

 11. In the File Format drop-down menu, select the target file's audio format. 

 12. Choose a method for creating the file name in the Mode for Creating File Names drop-
down menu. 

 13. Define other settings according to your preferences. 

 14. Click the Copy button. 

 Conversion starts. A folder with the album name is created in the desired folder. The 
audio files are saved in this folder and named according to the method you chose. A 
playlist file is created and saved in the same folder. Metadata that is identified with Gra-
cenote is written into the audio file.  
The Progress window indicates the saving progress. When the save process is com-
plete, this window is closed automatically. 

 15. Click the Close button. 

  The Save Audio Tracks to Hard Drive window is closed. You have saved audio 
files. 

5.4.1 Save Audio Tracks to Hard Drive Window 
Define the settings for audio files to be saved to the hard drive in the Save Audio Tracks to 
Hard Drive window. The window is opened by clicking the Extras > Save Audio Tracks 
menu. 

 
Save Audio Tracks to Hard Drive - Source 
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The following setting options are available: 

Tab 
Source 

Specifies settings for the source of the audio files. 

Tab 
Output 

Sets output files configuration options. 

Button 
Copy 

Starts the copy or save process. 

  

5.4.1.1 Source Tab 
The Source tab displays the audio files on the Audio CD. The functions of the control but-
tons correspond to the familiar control buttons on CD players. 

The following setting options are available: 

Drop-down menu 
Source drive 

Selects the drive where the Audio CD is inserted. 

Title Selection List Displays the tracks on the Audio CD. You can select individual tracks 
to copy by selecting the respective check box.  

Button 
Refresh 

Sends a new query to the Gracenote Media Database and com-
pletes the Audio CD's metadata including artist, title name, and ge-
nre if a matching entry exists in the database. 

Button 
Edit 

Opens the Edit Meta Data window. Here, you can edit the Audio CD 
metadata sent by Gracenote. You can enter the metadata if no entry 
for your Audio CD exists in the Gracenote Media Database. This 
metadata is sent to Gracenote, and added to the Gracenote Media 
Database.  

Input fields 
Album/Artist/Year 

Displays or specifies metadata for the album, artist and year. 

Selection list 
Genre 

Displays or specifies the genre. 

Cover area Displays Album Art, i.e., the cover of the Audio CD. 

Button 
Load Cover 

Loads an alternative cover from your hard drive. 
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5.4.1.2 Output Tab 
You can define the properties of the audio files to be created on the Output tab. 

 
Copy Audio CDs to Hard Drive - Output 

The following setting options are available: 

Input window 
Output directory 

Selects the storage location for the output file. 

Button 
Browse 

Opens a browser window where you can select a storage location. 

Drop-down menu 
Mode for creating 

file name 

Selects the method to be used for creating the name of the output 
file. 

Check box 
Automatically gen-
erate a playlist of 

stored audio tracks 

Creates a playlist of the saved audio files. A playlist is a list of the 
ripped audio files in the right order with the right metadata. It is a 
very convenient tool − you simply have to select the playlist to add all 
the audio files in contains to an audio compilation or a playback ap-
plication. 

Drop-down menu 
Playlist format 

Selects a format for the playlist. 
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Drop-down menu 
File format 

Selects the output audio format for the selected audio file. The se-
lected file format is available as the first entry the next time it is 
called up. You can choose between Nero AAC Audio, MP3 Audio, 

WAVE, AIFF, FLAC and Ogg Vorbis. 

Drop-down menu 
Quality 

Selects the bitrate for the selected audio file format. If the bit rate is 
small, less data is transferred. The file is then small, but quality is 
lower. If the bit rate is high, more data is transferred. The file size is 
then large, but the quality is high. A value of 128 for MP3 files is near 
CD quality. For the MP3 Audio file format you can also select if you 
want to create an MP3 file or an mp3PRO file.  
Only available if you selected the Nero AAC Audio or MP3 Audio 
file format. 

Check box 
Force compatibility 

with iPod 

Makes Nero AAC Audio available for an iPod. 
Is only available if you selected the Nero AAC Audio output format. 

Check box 
Disable ID3v2 Un-
synchronization 

Disables the ID3v2 Unsynchronization during the decoding process. 
ID3v2 Unsynchronization is a part of the MP3 decoding process. It 
increases the chance that the MP3 file can be played even with old 
software or hardware that does not support ID3v2. However, some 
devices that support ID3v2 do not support ID3v2 Unsychronization. 
The display of images or text tags might be corrupt on such devices 
when playing MP3 files with unsynchronized ID3v2. Select the check 
box if you have encountered such problems. 

Check box 
Add Album Art to 

file if available 

Adds Album Art to the files. Album Art works for example as a mini 
view in the Explorer. Adding Album Art increases the file size. 
Only available if Album Art is available or chosen for this Audio CD. 

  

5.5 Convert Audio File Format 
With Nero Burning ROM you can convert an audio file into another format, i.e. transcode the 
audio file (e.g. from WAV to MP3). 
The following formats are usually available (available formats may depend on the source 
format): 
  AC3: You can specify the bit rate for this audio format 
  AIFF: See Encoding Options AIFF→ 56 
  FLAC: It is not necessary to specify any settings for this lossless audio format 
  MP3 (Lame Encoder): See Encoding Options MP3→ 56 
  MP3/mp3PRO: See Encoding Options MP3/mp3PRO→ 58 
  Nero AAC Audio: See Encoding Options Nero AAC Audio→ 60 
  OGG: See Encoding Options OGG→ 61 
  WAV: See Encoding Options WAV→ 56 
  WMA: You can set different profiles for this audio format 
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5.5.1 Encode Files Window 
In the Encode Files window, the audio files that are to be encoded are selected and the 
properties of the output are defined. You can open the window via the Extras > Encode 
Files menu. The window consists of a selection area and the Properties area. 

 
Encode Files Window 

The following configuration options are available in the selection area: 

List 
Files to be encoded 

Displays the selected files. 

Check box 
Show full paths 

Displays the full source and destination paths for the files in the 
Files to be encoded list. 

Button 
Add 

Opens the browser window where you can select a file to add it to 
the list of files to be encoded. 
Clicking on the little triangle allows you to select audio files using 
Nero MediaBrowser. 

Button 
Remove 

Removes the selected file. 

Button 
Remove All 

Removes all files from the list of Files to be encoded. 

Button 
Reset Status 

Resets the status of the selected file back to Not done. 
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The following configuration options are available in the Properties area: 

Drop-down menu 
Output file format 

Selects the output audio format for the selected audio file. 

Button 
Settings 

Opens a window where you can define options such as bit rate 
and frequency for the output audio file. 

Display panel 
Target file 

Displays the storage location of the output file or output files. 

Button 
Browse 

Opens a browser window where you can select a storage location. 

Display panel 
Source file info 

Displays information on the selected audio file. 

  

The following buttons are available for the encoding process: 

Go Starts the encode process. 

Close Closes the window. 
  

5.5.2 AIFF and WAVE Encoding Options 
Nero Burning ROM can encode audio files in AIIF or WAV formats. 

Set options in the AIFF/Wave window that you can open in the Encode Files window via the 
Settings button. Ensure that you have selected AIFF or Wave as the Output file format. 

The following setting options are available in the AIFF or Wave window: 

Drop-down menu 
Frequency 

Specifies the scan rate per second and thus determines the frequen-
cy of scanning. The higher the frequency, the more frequently 
scanned. 

Drop-down menu 
Bits 

Specifies the scan accuracy and thus determines the quality of the 
individual scanner. The higher the bit sign, the more accurate. 

Drop-down menu 
Channels 

Specifies which channels are recorded. 
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5.5.3 MP3 Lame Encoding Options 
With Nero Burning ROM you can encode audio files in MP3 formats using the Lame Codec. 
Set these options in the MP3 Settings window that you can open in the Encode files win-
dow via the Settings button. Ensure that you have selected Lame MP3 Encoder as the Out-
put file format.  

The following encoding options are available in the Settings area: 

Drop-down menu 
Constant Bit Rate 

Selects a constant bit rate, i.e. the data flow per unit of time and 
the quality of the saved data are the same over the entire audio 
file. If the bit rate is small, less data is transferred. The file is then 
small, but quality is lower. If the bit rate is high, more data is trans-
ferred. The file size is then large, but the quality is high. The de-
fault value of 128 for MP3 files is near CD quality. 

Drop-down menu 
Variable Bit Rate 

Selects variable bit rate, i.e. the data flow per unit of time - and 
thus the quantity of the saved data - adapts to the dynamics of the 
audio file. The bit rate, for example, can be lowered at quieter 
points in the track. 
Select your desired quality level in the drop-down menu. 

  

The following encoding options are available in the Expert settings area: 

Drop-down menu 
Encoding quality 

Specifies the encoder quality. These settings specify whether you 
place more value on fast encoding (lowest/fastest) or more value 
on a superior psychoacoustic encoder model for the very best 
results (highest/slowest). 

Check box 
Original bit 

 

Sets the original bit in the music file, which differentiates between 
the copy and the original.  
Check box selected: Original bit = 1, i.e. original.  
Check box cleared: Original bit = 0, i.e. copy. 

Check box 
Private bit 

Sets the private bit in the music file. It is reserved for the user and 
is only used for informational purposes. 

Check box 
Copyright bit 

Sets the copyright bit in the music file, which identifies protected 
content. 
Check box selected: Copyright bit = 1, i.e. protected.  
Check box cleared: Copyright bit = 0, i.e. unprotected. 

Check box 
Write CRC 

Sets a checksum in the music file to ensure that transfer errors are 
detected. 
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5.5.4 MP3 and MP3PRO Encoding Options 
With Nero Burning ROM you can encode audio files in MP3 and MP3PRO formats. Set 
these options in the MP3PRO window that you can open in the Encode files window via the 
Settings button. Ensure that you have selected MP3/MP3PRO as the Output file format.  

 
MP3PRO window 

The following encoding options are available in the Settings area: 

Drop-down menu 
Encoder quality 

Specifies the encoder quality. Fast, Medium and Highest are 
available. These settings specify whether you place more value on 
fast encoding (Fast) or more value on a superior psychoacoustic 
encoder model for the very best results (Highest). 

Check box 
Constant Bit Rate 

Selects a constant bit rate, i.e. the data flow per unit of time and 
the quality of the saved data are the same over the entire audio 
file. If the bit rate is small, less data is transferred. The file is then 
small, but quality is lower. If the bit rate is high, more data is trans-
ferred. The file size is then large, but the quality is high. The de-
fault value of 128 for MP3 files is near CD quality. 

In the drop-down menu, select the Options that affect the bit rate: 
scan rate per second in kBit, scan frequency per second in Hertz 
and the channels. 
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Check box 
Variable Bit Rate 

Selects variable bit rate, i.e. the data flow per unit of time - and 
thus the quantity of the saved data - adapts to the dynamics of the 
audio file. The bit rate, for example, can be lowered at quieter 
points in the track. 
Select your desired quality level in the drop-down menu. 
Note that not all players are able to show the correct length of MP3 
files that were recorded with variable bit rate. 

  

The following encoding options are available: 

Check box 
Enable MP3PRO 

Specifies the encoder method used. If you select the check box, 
an MP3PRO file is created (*.mp3 file extension).  
If you clear the check box, an MP3 file is created (also *.mp3 file 
extension). 

Button 
Expert 

Opens the advanced area where you can configure Expert Fea-
tures. 

  

The following encoding options are available in the Expert Features area: 

Check box 
Original bit 

 

Sets the original bit in the music file, which differentiates between 
the copy and the original.  
Check box selected: Original bit = 1, i.e. original.  
Check box cleared: Original bit = 0, i.e. copy. 

Check box 
Private bit 

Sets the private bit in the music file. It is reserved for the user and 
is only used for informational purposes. 

Check box 
Copyright bit 

Sets the copyright bit in the music file, which identifies protected 
content. 
Check box selected: Copyright bit = 1, i.e. protected. 
Check box cleared: Copyright bit = 0, i.e. unprotected. 

Check box 
Write CRC 

Also sets a checksum in the music file to ensure that transfer er-
rors are detected. 

Check box 
Allow intensity stereo 

coding 

Uses a special codec at high frequencies that only saves the direc-
tional information and volume. 

Check box 
Allow downmix 

Mixes two stereo channels down to one mono signal. This option 
is useful when the output data is of such poor quality that a poor 
stereo signal is to be expected. An increase in quality is expected 
when downmixing to mono. 

Drop-down menu 
Padding 

Selects a padding type for MP3 blocks. We recommend padding 
type ISO that pads MP3 blocks according to the ISO specification. 
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5.5.5 Nero AAC Encoding Options 
Nero Burning ROM can encode audio files in the Nero AAC Audio format. 

Set options in the Nero AAC Encoder Settings window that you can open in the Encode 
Files window via the Settings button. Ensure that you have selected Nero AAC as the Out-
put file format.  

 
Nero AAC Encoder Settings 

The following setting options are available in the Nero AAC Encoder Settings window: 

Drop-down menu 
entry 

Variable Bitrate 

Specifies a variable bit rate, i.e. the data flow per unit of time and 
thus the quantity of the saved data adapts to the dynamics of the 
audio file. The bit rate, for example, can be lowered at quieter points 
in the track. 
You can set the variable bit rate between 0 and 100. 0 means the 
lowest, 100 the highest quality. 

Drop-down menu 
entry 

Average Bitrate 

Specifies an average bit rate, i.e. the data flow per unit of time and 
thus the quantity of the saved data adapts to the dynamics of the 
audio file but the average bit rate tends to the defined value. In prin-
ciple is it a variable bit rate with a limited bit band width and thus 
combining the advantages of the variable and the constant bitrate. 

Drop-down menu 
entry 

Constant Bitrate 

Specifies a constant bit rate, i.e. the data flow per unit of time and 
thus the quantity of the saved data is the same over the entire audio 
file. 
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Slider 
Quality 

Specifies the bit rate, i.e. the data flow per unit of time and thus the 
quantity of the saved data. 
If the bit rate is small, less data is transferred. The file is then small, 
but quality is lower. If the bit rate is high, more data is transferred. 
The file size is then large, but the quality is high. The default value of 
128 is near CD quality. 

Check box 
Use .m4a extension 

for writing files 

Encodes the audio files in the M4A audio file format; which was de-
fined by Apple. 

  

5.5.6 OGG Vorbis Encoding Options 
Nero Burning ROM can encode audio files in the OGG Vorbis format.  
Set options in the OGG Vorbis Settings window that you can open in the Encode Files 
window via the Settings button. Ensure that you have selected OGG Vorbis as the Output 
file format.  

The following setting options are available in the OGG Vorbis Settings window: 

Check box 
Constant Bit Rate 

Specifies a constant bit rate, i.e. the data flow per unit of time and 
thus the quantity of the saved data is the same over the entire audio 
file. 
If the bit rate is small, less data is transferred. The file is then small, 
but quality is lower. If the bit rate is high, more data is transferred. 
The file size is then large, but the quality is high. The default value of 
128 is near CD quality. 

Check box 
Variable Bit Rate 

Specifies a variable bit rate, i.e. the data flow per unit of time and 
thus the quantity of the saved data adapts to the dynamics of the 
audio file. The bit rate, for example, can be lowered at quieter points 
in the track. 
You can set the variable bit rate between 0 and 100. 0 means the 
lowest, 100 the highest quality. 
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6 Video 

6.1 Compiling DVD-Video 
With Nero Burning ROM you can burn DVDs made up of DVD-Video files from your hard 
drive. You can play your burned DVDs on almost all DVD players.  
You can use Nero Burning ROM to burn a DVD Video if the DVD video title, i.e. a complete 
DVD folder structure, is already available.  
 

 

In Nero Burning ROM it is not possible to convert video files to DVD-Video, an 
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD 
video, or BDMV-Video is possible in Nero Video for example. Nero Video is in-
cluded in the full version of Nero 11. More information about Nero Video is availa-
ble on the Web site www.nero.com, and more information about video editing is 
available in the separate Nero Video manual. 

 

To compile a DVD-Video, proceed as follows: 

 1. Select the DVD entry from the drop-down menu in the New Compilation window. (In case 
that the New Compilation window is not opened, it can be opened by clicking the New but-
ton on the main screen.) 

 2. Choose the DVD Video compilation type from the selection list. 

 The tabs with the configuration options that are valid for this compilation type are dis-
played. 

 
DVD Video Tab 

http://www.nero.com/�
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 3. Set the options you require on the tabs. 

 4. Click the New button. 
 The New Compilation window is closed and the selection screen is opened. 

 
DVD Video Compilation Screen 

 5. Select the DVD-Video files that you want to burn from the File Browser area on the right 
side.  

 6. Drag the existing DVD folder structure of the video title (VIDEO_TS) into the Disc Content 
area on the left side. 
 The files are added to the compilation and displayed in the compilation screen. The ca-

pacity bar indicates how much space is required on the disc. 
  You have successfully compiled a DVD-Video and can now burn this compilation. 

See also 
  Selection Screen →16 

6.2 Compiling an AVCHD Video Disc 
With Nero Burning ROM you can burn an AVCHD video disc made up of AVCHD video files 
from your hard drive or camcorder. The AVCHD video disc can be burned to a DVD as 
usual, or to a Blu-ray Disc. Burning to a Blu-ray Disc has the benefit that it offers more space 
than a DVD. 
AVCHD video on DVD is compatible to the specification of a Blu-ray Disc. However, play-
back is not guaranteed on all Blu-ray players. 
You can use Nero Burning ROM to burn an AVCHD video disc if the complete folder struc-
ture including premastered files is already available. 
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In Nero Burning ROM it is not possible to convert video files to DVD-Video, an 
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD 
video, or BDMV-Video is possible in Nero Video for example. Nero Video is in-
cluded in the full version of Nero 11. More information about Nero Video is availa-
ble on the Web site www.nero.com, and more information about video editing is 
available in the separate Nero Video manual. 

 

To compile an AVCHD video disc, proceed as follows: 

 1. Select the DVD or Blu-ray entry from the drop-down menu in the New Compilation 
window. (In case that the New Compilation window is not opened, it can be opened by 
clicking the New button on the main screen.) 

 2. Choose the AVCHD (TM) video compilation type from the selection list. 
 The tabs with the configuration options that are valid for this compilation type are dis-

played. 

 
AVCHD (TM) video - New Compilation Window 

 3. Enter a name for the AVCHD video disc in the Disc name input field. 

 4. Click the New button. 

 The New Compilation window is closed and the selection screen is opened. 
It includes the specific AVCHD folder structure. 

http://www.nero.com/�
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AVCHD video - Selection Screen 

 5. Select the movie that you want to burn from the File Browser area on the right side. 

 6. Drag the existing folder structure including premastered files into the Disc Content area on 
the left side. 
 The files are added to the compilation and are displayed in the compilation screen. The 

capacity bar indicates how much space is required on the disc. 
  You have successfully compiled an AVCHD video disc and can now burn this compi-

lation. 
 

 

Files and Folders 
The AVCHD video contains different folders. Only certain files are allowed in an 
individual folder. If you only have individual files, you must allocate the right files 
to the specific folder: 
\BDMV\index.bdmv 
\BDMV\MovieObject.bdmv 
\BDMV\PLAYLIST\*.mpls  
\BDMV\CLIPINF\*.clpi  
\BDMV\STREAM\*.m2ts  
\BDMV\AUXDATA\sound.bdmv  
\BDMV\AUXDATA\*.otf  
\BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be availa-
ble) 
Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be availa-
ble but may remain empty. 
If the folder \BDMV\BACKUP is available it contains a copy of the files in-
dex.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO. 
Additionally, an AVCHD video may contain the folder AVCHDTN. This folder must 
not be available if it is empty. If it is available, it has to contain the following files: 
\AVCHDTN\thumbnail.tidx  
\AVCHDTN\thumbnail.tdt2 
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6.3 Compiling a BDMV-Video Disc 
With Nero Burning ROM you can burn a BDMV-Video disc made up of BDMV (= Blu-ray 
Movie) files from your hard drive. You can play your burned BDMV-Video on almost all Blu-
ray players. 
You can use Nero Burning ROM to burn a BDMV-Video if the complete BDMV folder struc-
ture including premastered files is already available. 
 

 

In Nero Burning ROM it is not possible to convert video files to DVD-Video, an 
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD 
video, or BDMV-Video is possible in Nero Video for example. Nero Video is in-
cluded in the full version of Nero 11. More information about Nero Video is availa-
ble on the Web site www.nero.com, and more information about video editing is 
available in the separate Nero Video manual. 

 

To compile a BDMV-Video disc, proceed as follows: 

 1. Select the Blu-ray entry from the drop-down menu in the New Compilation window. (In 
case that the New Compilation window is not opened, it can be opened by clicking the 
New button on the main screen.) 

 2. Choose the BDMV-Video compilation type from the selection list. 
 The tabs with the configuration options that are valid for this compilation type are dis-

played. 

 
BD Video Compilation Window 

 3. Enter a name for the BDMV-Video disc in the Disc name input field  

http://www.nero.com/�
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 4. Click the New button. 

 The New Compilation window is closed and the selection screen is opened. 
It includes the specific and predefined BDMV folder structure. 

 
BD Video Selection Screen 

 5. Select the movie that you want to burn from the File Browser area on the right side. 

 6. Drag the existing BDMV folder structure including premastered files into the Disc Content 
area on the left side. 
 The files are added to the compilation and are displayed in the compilation screen. The 

capacity bar indicates how much space is required on the disc. 
  You have successfully compiled a BDMV-Video disc and can now burn this compila-

tion. 
 

 

Files and Folders 
The BDMV-Video contains different folders. Only certain files are allowed in an 
individual folder. If you only have individual files, you must allocate the right files 
to the specific folder: 
\BDMV\index.bdmv 
\BDMV\MovieObject.bdmv 
\BDMV\PLAYLIST\*.mpls 
\BDMV\CLIPINF\*.clpi 
\BDMV\STREAM\*.m2ts 
\BDMV\AUXDATA\sound.bdmv 
\BDMV\AUXDATA\*.otf 
\BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be availa-
ble) 
Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be availa-
ble but may remain empty. 
If the folder \BDMV\BACKUP is available, it contains a copy of the files in-
dex.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO. 
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7 Bootable Disc 
With Nero Burning ROM you can create a bootable disc with which the computer can be 
started without having to access the hard drive. For this reason a bootable disc is often used 
as an "emergency disc" to start the computer if it is not possible to access the hard drive. 
Bootable discs are created in accordance with the "El Torito" standard, an extension to the 
ISO-9660 standard, which defines the structure of data discs. The disc contains a boot im-
age and an ISO part. The boot image contains all files that are required to load the operating 
system and to start the computer. The ISO part can contain any number of data files that you 
can back up using this method. 

7.1 Requirements for Booting From a Disc 
To ensure that a computer can boot from disc, the start sequence must be set in the BIOS of 
the computer in such a way that the drive is addressed first as the boot drive (start sequence 
CD-ROM, C, A for instance). In the case of an SCSI CD-ROM drive, this drive must be con-
nected to an SCSI adapter with a separate BIOS in which settings can be modified accor-
dingly. (This will only work if there are no IDE hard drives present, as these come before the 
SCSI adapter in the boot sequence.) 
When booting from a disc, you can only start an operating system that does not write to the 
medium, such as "MS DOS" or "Linux". During booting, Microsoft Windows 2000 and Micro-
soft Windows XP write to the medium from which they are being booted. This is not possible 
with a disc and so the process is canceled and the PC cannot be started. 

7.2 Bootable Disc Template 
For Nero Burning ROM, the template for creating a bootable disc can be either a logical drive 
or a drive image file which contains the contents of a drive as a file sector for sector. If the 
template for the bootable disc is a logical drive, the bootable disc will emulate this when the 
system is booting. There are three emulation types: 

 

  Floppy emulation: This requires a bootable floppy disc for creating the bootable disc. At 
startup the bootable disc emulates a floppy disk. In the process, the drive letters incre-
ment, so that Drive A: corresponds to the bootable disc. The volume of the start data is 
limited by the capacity of the floppy disk (e.g. 1 MB). 

  Hard drive emulation: A bootable hard drive is required to create the bootable disc. At 
startup the disc emulates Drive C. All drive letters from Drive C increment by one. The 
volume of the start data is limited by the capacity of the CD (e.g. 700 MB) or DVD (e.g. 
8.5 GB). If, for instance, you have a 200 GB hard drive with only one (200 GB) partition, 
you cannot create a bootable disc from it without repartitioning your hard drive accor-
dingly beforehand. 

  No emulation: In this process the drive names are not changed. This type is used for 
bootable installation CDs. This setting is intended for users who do not require a floppy 
or hard drive emulation and who want to install their own device driver. 
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7.3 Creating and Burning a Bootable Disc 
To create a bootable disc, proceed as follows: 

 1. Click the New button in the main Nero Burning ROM screen. 

 The New Compilation window is opened. 

 2. Select the desired disc format from the drop-down menu. 

 3. Select the desired Boot compilation type. 
 The tabs for the bootable disc are displayed; the Boot tab is in front. 

 
Boot configuration 

 4. If the template data for the bootable disc should originate from a logical drive: 

 1. Select the Bootable logical drive option button in the Source of boot image data area. 
 2. Select the entry you want from the drop-down menu. 
 

 

If the logical drive you want does not appear in the drop-down menu, the reason 
for this is that the drive is bigger than the space available on the disc. Please note 
that for operating systems such as Microsoft® Windows® 2000 you need to have 
administrator rights in order to be able to access drives directly, which you will 
need to do if you are to create bootable discs. 
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 5. If the template data for the bootable disc should originate from an image file: 

 1. Select the Image file option button in the Source of boot image data area. 
 2. Click the Browse button and select the desired image file. 
 3. Select the Enable expert settings check box and select the emulation type for the im-

age file from the Kind of emulation drop-down menu if appropriate. 
 

 

DosBootimage 
Nero Burning ROM makes the boot image file DosBootimage.ima available. The 
path to the image file is entered in the Image file field by default. You can also 
select the language that should appear while the system is booting and select the 
correct keyboard layout from the Boot locale drop-down menu. 
DosBootimage is an image of the Caldera DOS boot floppy disk and emulates a 
floppy disk. The image contains drivers for reading from disc drives and supports 
FAT32 (read/write) as well as NTFS (read only). If you choose DosBootimage for 
the bootable disc, the expert settings are already predefined. 

 

 

 

If you choose an ISOLINUX boot image file, Nero Burning ROM sets the expert 
settings automatically correct for ISOLINUX bootable disc. 

 

 6. Select any other options required on the tabs. 

 7. Click the New button. 
 The selection screen is displayed.  

 8. Select the files/folders that should be written to the ISO part of the bootable disc and drag 
them into the Disc Content area. 

  The files/folders are displayed in the Disc Content area and the capacity bar indi-
cates how much storage space is required on the disc. You have now created the 
bootable disc and can start the burn process. 
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8 Loading Image File 
You can use Nero Burning ROM to burn a disc from a disc image that you have previously 
saved on the hard drive. 
To load a saved image file, proceed as follows: 

 1. Select a recorder from the drop-down menu. 

 2. Click the  button in the main screen. 

 The Open window is opened. 

 
Open window 

 3. Select the desired image file and click the Open button. 
 The Burn Compilation window is opened. 

 
Burn Compilation window 
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 4. Set the desired burn options. 

 5. If technically possible, you can change the disc type in the drop-down menu. 

 6. Click the Burn button. 
 The burn process is started. A progress bar indicates the progress being made by the 

burn process. When the burn process is complete the disc is ejected. 

 
Burning process 

  The burning process is complete. You can now remove the burned disc from the re-
corder. 
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9 LightScribe 
Using Nero Burning ROM and a LightScribe recorder you can create or load labels that you 
can burn onto the label side of CDs/DVDs in the LightScribe recorder. The function is availa-
ble as a separate Print LightScribe Label option in the start screen or can be integrated as 
an intermediate step into the creation and burn process of a project. 
 

 
This function is only available in recorders that support LightScribe technology. 

 

9.1 Printing LightScribe Label 
The process for printing the label is integrated into the burn process. First, the compilation is 
burned. You then flip the disc over, and the label is being burned. 
It is possible to burn the label several times to the same LightScribe disc. The printed labels 
will be aligned. This darkens the label und often improves the quality. It is also possible to 
extend the label with new elements in an additional burn process. 

The following requirement must be fulfilled: 

 ▲ A LightScribe recorder is selected. 
To print a label within your compilation, proceed as follows: 

 1. Select the desired compilation type in the New Compilation window.  
(In the case that the New Compilation window is not opened, it can be opened by clicking 
the New button on the main screen.). 

 2. Click the Misc tab. 
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 3. Select the Print label check box in the LightScribe area. 

 4. Click the Create button. 
 The CD Label Editor window is opened. 

 
CD Label Editor 

 5. Create your label or open an existing one that you have created with Nero CoverDesigner. 

 

The interface in the CD Label Editor window and the procedure for creating la-
bels work on the same principle as Nero CoverDesigner. Please see the Nero 
CoverDesigner user manual for full instructions on how to make professional look-
ing covers and labels. 

 

 6. Set further options that you require. 

 7. Click the New button.  
 The New Compilation window is closed and the selection screen is displayed. 

 8. Select the files to burn (see Compiling Data Disc→ 19). 

 9. Insert a blank LightScribe CD with the data side facing down. 

 10. Click the Burn Now button. 
 The burn process starts and the compilation is burned. A progress bar indicates the 

progress being made by the burn process. When the burn process is complete the disc 
is ejected. A window is opened with the message "Please insert a LightScribe disc in-
to the drive with the label side facing down". 
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 11. Insert the LightScribe disc into the recorder with the label side facing down and click OK. 

 The LightScribe Print Properties window is opened and the print process starts. In the 
LightScribe Print Properties window a progress bar indicates the progress being 
made. When the print process has finished, a window is opened with the message 
"Burn process completed successfully".  

 12. Click the OK button. 
  The disc is ejected. You have burned the compilation and printed a LightScribe la-

bel. 

See also 
  LightScribe Settings →114 

9.2 CD Label Editor Window 
In the CD Label Editor window, you can create or load a label. The window is opened when 
you click the Create button in the LightScribe area on the Misc tab for the current compila-
tion. 
 

 

The interface in the CD Label Editor window works on the same principle as 
Nero CoverDesigner. Basically, it is irrelevant whether you print the label on pa-
per or directly onto an appropriate disc. Please see the separate Nero CoverDe-
signer user manual for full instructions on how to make professional looking cov-
ers and labels. 

 

 

 
Document - CD Label Editor Window 



LightScribe 

 
Nero Burning ROM 76 

The following configuration options are available: 

Inner radius Defines the distance between the label and the inner edge. 

Outer Radius Defines the distance between the label and the outer edge. 

Width Defines the width of the print area. 

Label templates 
Contains a selection of different templates for designing the label. 
You can continue to edit and customize a selected template. 

New Generates a new label document. 

Open Opens an existing label which was created using Nero CoverDe-
signer. 

Save As Saves the label you have created. 

OK Adds the label you created to the compilation and closes the window. 

Preview Opens the Print Preview window that shows how the label should 
appear on the LightScribe disc. 

Cancel Cancels the procedure and closes the window. 
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10 Labelflash 
If you have a Labelflash recorder, you can print a label on the label and/or data side of the 
Labelflash DVD. A Labelflash DVD has a special layer between the top and bottom layers; 
this layer can be heated by the laser in the recorder so that images and text can be printed 
on the DVD.  
 

 

The interface in the Burn Label screen works on the same principle as Nero Co-
verDesigner. Basically, it is irrelevant whether you print the label on paper or di-
rectly onto an appropriate disc. 
Please see the separate Nero CoverDesigner user manual for full instructions on 
how to make professional looking covers and labels. 

 

 

 
This feature is only available in recorders that support Labelflash technology. 

 

10.1 Burn Label Window 
In the Burn Label window you can create or load a label and write it on a Labelflash DVD. 
Information on the selected printing quality and rotation speed is displayed on the right-hand 
side of the screen. Under Disc type you can see whether the blank disc has been inserted 
with the label or data side. Either the Labelflash or the DiscT@2 logo is displayed in the 
Burn Label window depending on which side is inserted. 

 
Burn Label Window 
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The following configuration options are available in the Burn Label window: 

Input field 
Inner Radius 

Defines the distance between the label and the inner edge. 

Input field 
Width 

Defines the width of the print area. 

Button 
Change 

Opens the Labelflash Print Properties window. 
This is where you can change the printing quality and the contrast 
level and display the changes made directly in the print preview. 

Button 
Preview 

Opens the Print Preview window that shows how the label should 
appear on the Labelflash disc. 

Selection list 
Label templates 

Contains a selection of different templates for designing the label. 
You can continue to edit and customize a selected template. 

Button 
Burn 

Starts the burn process. 

Button 
Cancel 

Cancels the procedure and closes the window. 

  

 

If you are creating a DiscT@2, Nero Burning ROM displays only the available 
print area for creating the label by default, i.e. the area on the data side of your 
DVD that is not already taken up by data. You cannot increase the radius of the 
print area. 

 

10.2 Printing Labelflash Labels and DiskT@2 
Basically, it is irrelevant whether you print on the label or the data side when creating labels. 
The label is actually printed outside the normal burn process. 
 

 

You can print on the label side of the DVD at any time.  
We recommend that you print on the data side first when you have burned the 
compilation. It is not possible to burn data on a printed data side. When you insert 
a DVD on which data has already been burned, Nero Burning ROM automatically 
identifies the space that is still available on the data side and on which you can 
print. 

 

To print a Labelflash label on the label side or a DiskT@2 on the data side of your DVD, 
proceed as follows: 

 1. If you want to print a Labelflash label on the label side, insert a blank Labelflash disc into the 
recorder with the label side facing down. 
 The Burn Label window is opened with the Labelflash logo.  
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 2. If you want to print a DiskT@2 on the data side, insert a blank Labelflash disc with the data 
side facing down in the recorder. 
 The Burn Label window is opened with the DiskT@2 logo.  

 3. Create a label according to your requirements or open a label that you have already created 
with Nero CoverDesigner. 

 

 

The interface in the Burn Label window and creation of a label work on the same 
principle as Nero CoverDesigner. See the separate Nero CoverDesigner manual 
for full instructions on how to create professional looking covers and labels. 

 

 4. If you want to change the area in which the label is printed, change the print area 
accordingly using the input fields Inner Radius and Width. 

 5. If you want to view or change the print properties: 

 1. Click the Change button. 
  The Labelflash Print Properties window is opened. 

 2. If you want to change the printing quality, select a quality level from the Print quality 
profile drop-down menu. 

 3. If you select the User defined entry from the Print quality profile drop-down menu, you 
can change the contrast level and the rotation speed. 

 4. Click the OK button. 
  The Labelflash Print Properties window is closed and the changes are accepted. 

 
Labelflash Print Properties 
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 6. Click the Burn button.  

 The labeling procedure starts and the Labelflash - printing or DiscT@2 - printing win-
dow is opened. The window shows the estimated printing time and the print progress. 
When printing is complete, a message window is opened informing about the successful 
print process. 

 7. Click the OK button. 
 The message window is closed and the disc ejected. 

  You have successfully printed a label. 
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11 Burn Compilation 

11.1 Choose Recorder Window 
In the Choose Recorder window you can select a recorder for burning. You can open the 
window via the button which is on the right side of the recorder drop-down menu. The win-
dow shows useful information about the recorder (e.g. supported disc types). In the ad-
vanced area you can set expert options. The available options depend on the chosen re-
corder. 

 
Choose Recorder 

The following setting options are available in the advanced area: 

Check box 
Buffer underrun 

protection 

Provides buffer underrun protection. 

This feature is particularly useful for burning CDs. 

Check box 
Write extended 

lead-out on double-
layer discs 

Writes an extended lead-out of 515 MB on the second layer of a 
double-layer multisession DVD when this area contains less data. 
Doing so improves the read compatibility. 
This feature is particularly useful for burning a data multisession 
DVD on a double-layer disc. It is not needed when the DVD is going 
to be finalized. 
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Check box 
DVD high compati-

bility mode 

Burns the DVD up to a radius of at least 1.2 inch (~ 30 mm, approx. 
1 GB), even when the compilation contains less data. In doing so the 
DVD is forced to meet the DVD-Video specification which reduces 
the possibility of read errors. 
This feature is particularly useful for burning DVD-Videos. 

Check box 
BD defect man-

agement 

Burns the Blu-ray Disc in defect management mode. In doing so the 
burner allocates part of the disc so that it is able to burn the data that 
has been damaged in a write error once again. BD defect manage-
ment reduces the write speed but increases data security. 
This feature is particularly useful for burning data Blu-ray Discs or for 
burning backups to Blu-ray Discs. 

Drop-down menu 
Book Type Settings 

Defines the book type setting for a DVD. 

This feature is particularly useful for burning to a blank DVD. 
  

 

 

Four book type settings are available: 
Automatic: Automatically selects the most suitable book type for this DVD. 
DVD-ROM: Sets the book type to DVD-ROM. Select this setting if the DVD is to 
be played on several DVD players or your DVD player has difficulties with self-
burned DVDs or of the DVD-, DVD+ or DVD-RW specification. 
Physical disc type: Selects the book type which is specified on the DVD. 
Current recorder setting: Leaves the book type setting to the recorder. 
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11.2 Burn Settings 
The Burn tab on the Burn Compilation window provides options for the burn process. 
Which options are enabled, depends on the chosen compilation. 

 
Burn Tab 

The following check boxes are available in the Action area: 

Check box 
Determine maximum 

speed 

Checks how fast the compiled data can be accessed and re-
duces the selected write speed if necessary. This prevents a 
buffer underrun. 
Recorders with a feature to prevent buffer underruns do not 
require a speed test. 
Not available when saving with Nero Image Recorder. 

Check box 
Simulation 

Simulates burning. In the process the simulation performs all 
steps that are also carried out during burning with the excep-
tion of setting the laser beam. A test determines whether there 
is a constant flow of data. 

Check box 
Write 

Enables the Burn button. 
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Check box 
Finalize disc 

Closes the disc so that you cannot write to this disc anymore. 
Depending on the disc format, finalizing may be necessary. 
Nero Burning ROM automatically selects this check box for the 
relevant disc formats. 

Check box 
SecurDisc Surface Scan 

Checks the quality of the disc surface after the burn process. 
You can use this option particularly when burning backups or 
discs that have to be archived to ensure that the disc surface 
does not have any issues and that burning went well. 
This check box is only active if Verify written data is selected. 

  

The following configuration options are available in the Writing area: 

Drop-down menu 
Write speed 

Selects the write speed at which the disc is burned. 

Drop-down menu 
Write method 

Selects the method used to burn the disc. The following me-
thods are available. 
Track-at-once: Burns each audio file (track) separately onto 
the disc, i.e. the laser is turned off and turned on again after 
each audio file. 
Disc/Session-at-once: Burns each session of a multisession 
disc separately onto the disc. 
Disc-at-once/96: Burns the entire disc in one go without hav-
ing to turn off the laser between individual audio files. The disc 
is finalized after burning. 

Input field 
Number of copies 

Defines the number of discs that are to be burned. The default 
is set to one disc. 

Check box 
Buffer underrun protec-

tion 

Provides buffer underrun protection. 
This check box is only available for a CD and if the selected 
burner supports a method which offers buffer underrun protec-
tion. 

Check box 
Using multiple recorders 

Burns the compilation to multiple disc. When you click the 
Burn button, a window is opened in which you can select the 
desired recorders. The burn process is then carried out simul-
taneously on the selected recorders. 

  

 

 

The speed test and simulation are not required for recorders that have a function 
for protecting against buffer underruns. Current recorders mostly have such a 
feature. 

 

 

 

Audio CDs should always be burned using the disc-at-once method. This entry is 
selected by default. 
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11.3 Starting the Burn Process 
 

 

Many CD players cannot read rewritable CDs (CD-RW). You should therefore use 
normal CD-ROMs for burning Audio CDs. 

 

To start the burn process, proceed as follows: 

 1. Choose a recorder from the drop-down menu in the main screen.  

 2. Insert an appropriate blank disc. 

 3. If technically possible you can change the disc type in the drop-down menu. 

 

You can select an appropriate disc format without loss of information at any time 
in the main screen. Note that this has to be technically possible - for example you 
are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD 
and change later to a data DVD, for example. The possibility to change the disc 
type is useful when starting a compilation without knowing how much space is 
required by the files. 

 

 4. If you want to check or select the options regarding this compilation type: 

 1. Click the Burn button in the main screen. 
  The Burn Compilation window is opened; the Burn tab is in front.  

 2. Check or select the options on the individual tabs. 
 3. Click the Burn button.  

 5. If you want to start directly, click the Burn Now button in the lower main screen. 
 If the Select multiple recorders check box was selected, the Select Recorder window 

is opened. 

 6. Select recorders here and click the OK button. 
 The burn process is started. On the screen a progress bar indicates the progress being 

made by the burn process. You have some options during the burn process. 
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Burning process 

 7. If you want to shut down the PC after burning (as long as this is technically feasible), select 
the Automatically shut down the PC when done check box. 

 8. If you want to check the written data after burning, select the Verify written data check box. 

 9. If you want to check the disc surface after burning, select the SecurDisc Surface Scan 
check box. 
 If the SecurDisc Surface Scan check box is selected, the SecurDisc Surface Scan 

Results window is opened. 
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Surface Scan window 

 Nero Burning ROM starts with the surface scan. The results are displayed in realtime.  
 When the burn process has finished, a message window is opened. 

 10. If you want to display the extended area with the event log, click the Details button. 

 11. If you want to start another burn process with the same compilation, click the Burn Again 
button. 

 12. Click the OK button. 
  The burning process is complete. You can now remove the burned disc from the re-

corder. 
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11.3.1 SecurDisc Surface Scan Results 
On the SecurDisc Surface Scan Results window the results of the surface scan are dis-
played in realtime. The scan test is carried out after the burn process when the SecurDisc 
Surface Scan check box is selected, either on the Burn tab or in the Burning process 
screen. 
The surface scan lets you check the quality of the disc with respect to completeness of the 
sectors. The test results are displayed both in a graph and in detail in the display panel be-
low the graph. 

 
SecurDisc Surface Scan 

The graph shows all sectors on the disc in one chart, with each sector being plotted with a 
small square. Each square, i.e. each sector, is displayed in a different color depending on its 
status. The Surface Scan area shows the respective percentage of sectors in the following 
three categories: Good, Damaged, and Bad in real time while the test is running. 
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The following colors, i.e. status indicators, are available: 

Green Readable sectors with no errors. 

Yellow Damaged sectors that can still be read using the recorder's internal 
error correction feature. 

Red Damaged sectors that cannot be corrected and are consequently 
unreadable. 

  

The following display panels are also available in the Surface Scan area while the test is 
running: 

Progress Shows the progress of the test, i.e. the percentage of the disc al-
ready scanned. 

Position Indicates continuously the current position of the read head on the 
disc. 

Speed Shows the scanning speed. 
  

The following information is available in the columns in the display panel: 

File Lists the names of the files on the disc in the drive. 

Position Shows the exact position of the file on the disc. 

Length Shows the length of the individual files. 

Quality Specifies the quality of the files. This score is calculated from the 
number of errors found. 
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11.4 Burning With Image Recorder – Creating an Image File 
With Nero Burning ROM and the Image Recorder you can create disc images from every 
compilation. The NRG image file format can always be selected whereas the ISO image file 
format can only be selected from certain compilation types. Nero Burning ROM only enables 
the possible image file formats. 
The NRG image file format was developed by Nero. In contrast to ISO, NRG can be created 
from every disc and compilation type. This means that even Audio CDs or multisession discs 
can be saved as an NRG image file. 
To create an image file, proceed as follows:  

 1. Click the New button. 

 2. Create a new compilation of your choice. 
 

 

Using Nero Burning ROM you can create image files for disc types that the in-
stalled recorder cannot burn. You can enable this function via the File > Options 
> Expert Features menu, Enable all Nero supported disc types for the Image 
Recorder check box. The drop-down menu in the Compilation window then 
makes available all supported disc types. 

 

 3. Select the files that you want to burn. 

 4. If you have installed multiple recorders, select Nero Image Recorder from the drop-down 
menu. 

 5. Click the Burn button. 
 The Burn Compilation window is opened; the Burn tab is in front. 

 6. Click the Burn button. 
 The Save Image File window is opened. 

 7. Specify a file name and a storage location for the image file and click the Save button. 

 The image file is created and saved in the selected storage location. On the screen, a 
progress bar indicates the progress made while the file is being created. Once the crea-
tion process is over, a message window is opened.  

 8. Click the OK button. 
  The message window is closed and you have successfully created the image file. 

See also 
  Expert Features →112 
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12 Copying a Disc 

12.1 Methods of Copying 
Nero Burning ROM can be used for copying discs. There are two methods for this: 

 

  On-the-fly 
  Copy Over Image 
Each method has advantages and disadvantages which will depend on your requirements. 

12.1.1 On-the-fly Copying 
When using the on-the-fly method, insert the original disc into a drive and a recordable disc 
into the drive. The original disc in the drive is copied immediately without any time delay to 
the blank disc in the recorder. The on-the-fly method allows you to copy discs very quickly, 
and does not require any additional space on the disc. 
In order to be able to use the on-the-fly method, you will need at least two drives: one for 
reading the disc and a disc burner for writing. The following requirements apply to the read 
drive and disc burner: 

 

  The disc burner must feature buffer underrun protection, or the drive must be capable of 
delivering the data sufficiently quickly. The read speed should be at least twice as fast as 
the write speed.  

  The read drive must be capable of delivering information on the number and type of ses-
sions, otherwise Nero Burning ROM may not be able to produce an exact copy.  

If you want to copy Audio CDs, we recommend the copy image method because the quality 
of the read audio files can suffer depending on the drive.  

12.1.2 Copy Over Image 
With the copy over image method, an image of the original disc is saved to a file first. The 
image file is then burned to a blank disc. Copying using copy over image takes longer, but it 
often produces better results. 
You must have sufficient storage space to use the copy over image method. 
The copy over image method is particularly suitable in the following situations: 

 

  Only one drive is available. 
  You would like to make several copies of the same disc. 
  You think it likely that read errors may have occurred on the source CD (for example 

because it is scratched). 
  You attach importance to the best possible reproduction (particularly in relation to index 

positions and the quality of Audio CDs). 
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12.2 Copying Disc 
With Nero Burning ROM you can copy a disc. That means you make an exact copy of a 
source disc and burn it to a target disc. If your source disc is an Audio CD, for instance, your 
copy will be an Audio CD as well. Depending on your installed burner, you can copy CDs, 
DVDs or Blu-ray Discs. The target disc must be the same disc type as the source disc - you 
can copy a DVD only to a DVD, for example. In any case, Nero Burning ROM will give you a 
message when the disc type do not fit. 
 

 

If you are not in possession of the copyright for the relevant disc and do not have 
authorization from the owner of the copyright, unauthorized copying of discs vi-
olates national and international legislation. 

 

 

 

Some discs are copy-protected and cannot be copied. If you are not sure whether 
your disc can be copied, activate simulation before commencing the actual physi-
cal burn process. 

 

To copy a disc, proceed as follows: 

 1. Click the Copy button in the main screen. 
 The New Compilation window is opened. 

 
Copy Disc window 
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 2. Select the disc format (CD, DVD, Blu-ray Disc) you want from the drop-down menu. 

 3. Choose the type of disc to be copied (e.g. Audio CD, Karaoke CD, DVD-Video, Data Blu-ray 
Disc) from the Profile selection drop-down menu on the Read Options tab. 

 
Read Options tab 

 The read options are optimally set for the particular type of disc. 

 4. If you want to copy discs using the On-the-fly method: 

 1. Select the On the fly check box on the Copy Options tab. 
 2. Select the drive that contains the source disc from the Drive drop-down menu.  
 3. Insert the source disc into the selected drive. 
 4. Insert a blank disc into another drive. 

 5. If you want to copy discs using the Copy Over Image method: 

 1. Clear the On the fly check box on the Copy Options tab. 
 2. Select the drive that contains the source disc from the Drive drop-down menu.  
 3. Insert the source disc into the selected drive. 
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Copy Options tab 

 6. Click the Copy button. 

 If you are copying via the drive, the copy process starts. If you are using Nero Image 
Recorder, the Save Image File message window is opened. 

 7. Enter a name for your image file in the File Name text box. 

 8. Select the relevant storage location in the Save to directory tree and click the Save button. 

 The copy and/or save process starts. You can follow the process status in the status bar. 
If you are using a single drive for copying, you will be prompted to remove the source 
disc and to insert a suitable blank disc after the image file has been written. 

 9. Click the Next button. 

  You have successfully copied a disc. 
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12.3 Copy Settings 
In the New Compilation window, define the options for copying at the beginning of the copy 
procedure. You can use the Copy button in the main screen to open the window. The New 
Compilation window consists of a drop-down menu, various buttons, and tabs.  

 
Copy settings 

Only those disc types supported by the recorder are displayed in the drop-down menu. If the 
recorder can only burn CDs, the drop-down menu is grayed out. 

 

Using Nero Burning ROM you can create image files for disc types that the in-
stalled recorder cannot burn. You can enable this function via the File > Options 
> Expert Features menu, Enable all Nero supported disc types for the Image 
Recorder check box. The drop-down menu in the Compilation window then 
makes available all supported disc types. 

 

The following configuration options are available: 

Button 
Disc Info 

Displays information on the disc inserted, such as contents (if any) or 
available capacity. 

Button 
Copy 

Starts the copy process. 

Button 
Cancel 

Closes the New Compilation window. 
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The following tabs are available: 

Image  Gives the path to the temporary image file and provides information 
on the speed of the hard drive. 

Copy Options Contains options for configuring copying. 

Read Options Contains options for configuring reading of the original disc. 

Copy Contains options for configuring the burn process. 
  

 

12.3.1 Image Settings 
The Image tab provides the two areas Image file and Hard drive speed info. The Image 
file area is only enabled if the On-the-fly check box is cleared on the Copy Options tab. 

The Image tab provides the following configuration options in the Image File area. 

Input field 
Path 

Displays the path of the temporary image file. 
 

Check box 
Delete image file after 

disc copy 

Deletes the temporary image file when the copy process is fi-
nished. 

Button 
Browse 

Opens the Save As window where you can specify a file name 
and a directory where the temporary image file should be stored. 

  

The following configuration options are available in the Image tab in the Hard drive speed 
info area: 

Drive List Lists the available hard drives with their free space.. 

Button 
Test Speeds 

Tests how far the available drives can be accessed and adds the 
speed found to the list. 
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12.3.2 Copy Options 

 
Copy Options tab 

In the Copy Options tag the following configuration options are available in the General 
area. 

Check box 
On-the-fly 

Creates the copy using the on-the-fly method.  
If this check box is cleared, the copy is created using the copy-
over-image method. 

  

The following configuration options are available in the Copy Options tab in the source 
area: 

Drop-down menu 
Drive 

Selects the drive for reading the disc.  
If a copy over image is created, we recommend that you select 
the recorder for reading in. 

Drop-down menu 
Read speed 

Defines the speed at which the disc is read in. 
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12.3.3 Read Options 
The Read Option tab consists of several areas. In these areas it is possible to set options 
for reading an original disc. 

 
Read Options tab 

The following configuration options are available in the Profile area: 

Drop-down menu 
Profile selection 

Selects predefined copy settings or a user-defined setting. 
In the case of predefined copy settings, Nero Burning ROM sets 
the configuration options automatically. You can select the confi-
guration options yourself with a user-defined setting. 

  

The following configuration options are available in the Data tracks area for the CD disc 
type: 

Check box 
Ignore read errors 

Ignores read errors on the original disc and continues the read 
process. 
If this check box is cleared, Nero Burning ROM may interrupt the 
burn process depending on the type of error. 

Check box 
Write defect sectors 

Passes on corrupt sectors anyway (that have caused read errors) 
for burning. 
If this check box is cleared, corrupt sectors are not passed on and 
remain blank. 
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Check box 
Read sectors in raw 

mode 
Reads PQ subchannel data. 

Check box 
Read all subchannel 

data 

Reads all subchannel data during copying. Subchannel data is 
used to save additional information. 
The burner has to be capable of reading all the subchannel data. 

  

The following configuration options are available in the Audio tracks area for the CD disc 
type:  

Check box 
Ignore read errors 

Ignores read errors on the original disc and continues the read 
process. 
If this check box is cleared, Nero Burning ROM may interrupt the 
burn process depending on the type of error. 

Check box 
Read indexes of au-

dio data 

Reads the audio file indexes. This is particularly useful for copying 
an Audio CD as it makes sure that all index positions of the Audio 
CD are copied correctly. The disadvantage is that it increases the 
time it takes to analyze a disc before the copy process starts. 

Check box 
Read all subchannel 

data 

Reads all subchannel data during copying. Subchannel data is 
used to save additional information, e.g. CD Text.  
The burner has to be capable of reading all the subchannel data. 

  

The following configuration options are available in the Advanced area for the CD disc type: 

Check box 
Read Media Catalog 
Number and ISRC 

Reads the media catalog number, a globally unique number for 
compilations, and the ISRC (International Standard Recording 
Code), a globally unique number for audio recordings. 

Check box 
Use jitter correction Jitter corrector removes scratches from audio and video files. 

  

The following configuration options are available in the Error correction area for DVD and 
Blu-ray Disc: 

Option button 
Read with error cor-

rection 

Performs error correction while reading. In the process, the check-
sum of a corrupt sector is adjusted so that the sector in itself is 
consistent. 

Input field 
Read retry count 

Establishes the number of attempts that are made to correct er-
rors. 

Option button 
Fast reading without 

error correction 
Performs fast reading without error correction. 
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The following configuration options are available in the Handling of non-correctable read 
errors area for DVD and Blu-ray Disc: 

Check box 
Ignore read errors 

Ignores read errors on the original disc. 
If this check box is cleared, Nero Burning ROM may interrupt the 
burn process depending on the type of error. 

  

 

 

With Audio CD, read errors often have little or no impact because they are not 
perceptible when the CD is played. 
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13 Erase Rewritable Disc Window 
Nero Burning ROM can be used to erase rewritable discs, i.e. discs with the RW specifica-
tion, as long as your recorder supports this feature. Two erase methods are available for this 
purpose: 
Quick erasing does not remove the data physically from the disc, but instead only makes it 
inaccessible by erasing the references to existing content. The data can be restored! 
Full erasing removes the data from the disc by overwriting it with zeros. The contents cannot 
be restored with conventional methods. Repeated full erasing increases the probability that 
third parties will not be able to reconstruct the contents. 

 
Erase Rewritable Disc window 

 

The following configuration options are available in the Erase Rewritable Disc window: 

Selection list 
Select recorder 

Defines the desired recorder. 

Check box 
Use multiple recorders 

Simultaneously erases CDs/DVDs in multiple recorders. 
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Selection list 
Select the erase me-

thod to be used 

Defines the erase method. Two options are available: 
The Quick-erase rewritable disc method does not physically 
erase all data from the disc, but only the references to the con-
tents. The disc will appear to be empty even though the data is 
still physically available. Erasing a disc using this method takes 
between one and two minutes. 
The Full-erase rewritable disc method physically erases all 
data from the disc. The contents cannot be restored with con-
ventional methods. Repeated full erasing increases the proba-
bility that third parties will not be able to reconstruct the contents. 
Erasing the disc using this method takes longer than the other 
method, depending on the type of disc involved. 

Selection list 
Erase speed 

Defines the erase speed. 

Button 
Erase 

Starts the erase process. 

Button 
Cancel 

Cancels the action and closes the window. 
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14 About Nero SecurDisc Viewer 
Nero SecurDisc Viewer is a standalone application that is part of the SecurDisc technology 
platform. SecurDisc is a technology developed by Nero and HLDS to create discs with spe-
cial protection properties. No special hardware is needed. 
Nero SecurDisc Viewer is available as a free download at www.securdisc.net or 
www.nero.com and is also included automatically in a SecurDisc disc that is burned with 
Nero Burning ROM or Nero Express. 
Discs that are created with Nero and the SecurDisc compilation type include data integrity 
and reconstruction. Additionally the data on the SecurDisc disc can be protected against 
unauthorized access by using a password. The data can also be digitally signed. Nero Se-
curDisc Viewer allows you to copy the protected data to your hard drive and to check the 
security of the data. 

 
More information on SecurDisc technology can be found at www.securdisc.net. 

See also 
  Compiling a SecurDisc disc →24 

14.1 Starting Nero SecurDisc Viewer 
Nero SecurDisc Viewer is included automatically in a SecurDisc disc that is burned with Nero 
Burning ROM or Nero Express. Insert the SecurDisc disc in a drive to open Nero SecurDisc 
Viewer automatically.  
Nero SecurDisc Viewer can also be opened by double-clicking the NeroSecurDiscView-
er.exe file. This file can either be found on the SecurDisc disc or it can be downloaded from 
www.securdisc.net or www.nero.com.  

 
Main screen 

http://www.securdisc.net/�
http://www.nero.com/�
http://www.securdisc.net/�
http://www.securdisc.net/�
http://www.nero.com/�
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14.2 Copying Data to Hard Drive 
With Nero SecurDisc Viewer you can copy the files from the SecurDisc disc to your hard 
drive. If the files have been protected against unauthorized access, you can insert the pass-
word here. 
Proceed as follows: 

 1. Select the check boxes of the files you want to copy to the hard drive. 

 2. Click the Save to button. 
 If data on the SecurDisc disc is password-protected, the Password Protection window 

is opened. 

 
 

 3. Enter the password in the text box and click the Apply button. 
 An explorer window is opened. 

 4. Select the required folder and click the OK button. 
 The Copy Data window is opened and the files are copied. You can follow the progress 

with the status bar and the displayed messages. As soon as the copy process is fi-
nished, a message is displayed to notify you. 
  The selected files are copied to the selected folder. 
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14.3 Checking Data Integrity 
Nero SecurDisc Viewer can be used to check the data integrity of a SecurDisc disc by using 
the checksum feature. The data integrity check warns you if the data on a disc is at risk of 
disc decay so that you have time to back it up to another disc. 
Proceed as follows: 

 1. Click the Integrity button. 

 The File Integrity Check window is opened and the integrity check is carried out. You 
can follow the progess with the status bar and the displayed messages.  
  As soon as the integrity check is finished, a message is displayed to notify you about 

the result of the check. 
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14.4 Checking Signature 
With Nero SecurDisc Viewer you can verify the authenticity of the SecurDisc disc if it is digi-
tally signed. You need the public key from the distributer of the SecurDisc disc for this pur-
pose. By checking the public key, Nero SecurDisc Viewer is able to confirm that the data is 
authentic and has not been manipulated. 
Proceed as follows: 

 1. Click the Signature button. 
 An explorer window is opened. 

 2. Select the public key (*.bpk) which the SecurDisc disc is signed with. 
 

 

Public key 
The creator of the SecurDisc disc has also created or selected the public key for 
the disc. The key is to be distributed by the creator of the disc, too. 

 

 3. Click the OK button. 
 The explorer window is closed and the Check window is opened.  
 The signature is checked. You can follow the progess with the status bar and the dis-

played messages. 
  As soon as the copy process is finished, a message is displayed to notify you about 

the result of the check. 
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15 Nero MediaBrowser 
Nero MediaBrowser is a tool which you can use to easily find, view and access media files 
and add them to your project. 
More precisely, with Nero MediaBrowser you can access a media library which contains all 
your media files that were indexed by Nero Kwik Media. Nero MediaBrowser is designed to 
be accessed in several Nero applications. 
 

 

Nero MediaBrowser and the media library come with Nero Kwik Media and are 
installed together. You will find further information in the Nero Kwik Media ma-
nual. 

 

Nero MediaBrowser can be opened via the  icon. Although Nero MediaBrowser can be 
moved freely around your desktop, it is part of Nero Burning ROM. 
Nero MediaBrowser displays only media files which can actually be used in the relevant Ne-
ro Burning ROM project. To add media files to your project, select the media files in Nero 
MediaBrowser and click the Add button. 

 
Nero MediaBrowser 
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The browsing task bar is the starting point for browsing Nero MediaBrowser. The categories 
(Photos & Videos, Music and Projects) are the same as featured in Nero Kwik Media. 
Each of the categories offers a search bar. It is only possible to search within one category 
at the same time. When one of the categories is clicked, the corresponding browsing area is 
displayed below. 

There are different views available for each category: Clicking one of the entries in the upper 
part of the list (for example Timeline) displays the same view as when clicking the corres-
ponding tabs in Nero Kwik Media. Clicking one of the collections in the lower part of the list 
displays the collection contents made within Nero Kwik Media. When one of the list items is 
clicked in Nero MediaBrowser, the corresponding content is displayed in the content area 
below. 

A dynamic scroll bar is used in the content area. If the scroll thumb is dragged in a direc-
tion, the content will be constantly scrolled in this direction. The scrolling speed increases the 
further the scroll thumb is dragged from the center. If the scroll thumb is released it jumps 
back to the center position and stops the scrolling. 

 

The following views are available for the Photos & Videos category: 

Entry 
Timeline 

Displays all photos and videos sorted in chronological order by crea-
tion date. 

Entry 
Faces 

Displays all photos in which faces of persons have been detected 
and named listed in alphabetical order. Unconfirmed or unnamed 
faces are not displayed. Faces are grouped into stacks; you can 
access one of the stacks by double clicking it. 
Nero Kwik Faces has to be installed. 

Collection 
Marked 

Displays the currently marked content. 
Refers to Marked in the sidebar of Nero Kwik Media. 

Collection 

 Album 

Displays the content of smart albums and user generated albums. 
Refers to Photo & Video Albums in the sidebar of Nero Kwik Me-
dia. 

Collection 

 Person group 

Displays the content of user generated person groups. You can 
switch between full photo and faces only view with the  /  
icon. 
Refers to Faces in the sidebar of Nero Kwik Media. Nero Kwik Faces 
has to be installed. 

  



Nero MediaBrowser 

 
Nero Burning ROM 109 

The following views are available for the Music category: 

Entry 
Album 

Displays all audio tracks sorted in alphabetical order by album. 

Entry 
Artist 

Displays all audio tracks sorted in alphabetical order by artist. 

Entry 
Genre 

Displays all audio tracks sorted in alphabetical order by genre. 

Collection 
Marked 

Displays the currently marked content. 
Refers to Marked in the sidebar of Nero Kwik Media. 

Collection 

 Playlist 
Displays the content of user generated playlists. 
Refers to Playlist in the sidebar of Nero Kwik Media. 

  

The following view is available for the Projects category: 

Entry 
Timeline 

Displays all projects sorted in chronological creation date order. 

Collection 
Slide Show 

Displays the content of user generated slide shows. 
Refers to Slide Show in the sidebar of Nero Kwik Media.  

Collection 
Photobook 

Displays the content of user generated photobooks. 
Refers to Photobook in the sidebar of Nero Kwik Media. 

  

The Options window is opened when you click the  button on the upper task bar. The 
options refer directly to Nero Kwik Media. The following setting option is displayed: 

Library 

Displays the Library Manager settings area. 
Three default folders (the Windows default folders) for Photos, Mu-
sic, and Videos are available in the Watched folders or drives 
area from the start. If you want to add personal media folders, click 
the Add button and select the desired folder from the navigation tree. 
The library is refreshed when launching Nero Kwik Media. To delete 
a folder from the application's watchlist, click the  button. 
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16 Configuration Options 
You can define options for working with Nero Burning ROM in the Options window.  

 
Options Window 

 

The following tabs are available: 

Compilation Contains options for the compilation and the selection screen. 

Cache Contains options for the cache. 

Font Contains selection options for the font. 

Sounds Contains selection options for sounds in connection with burn tasks. 
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Expert Features 
Contains options for configuring overburning and burning.  
We recommend that you retain the default settings. 

Database Selects the default naming method for audio files to be saved from 
an Audio CD to the hard drive. 

Ultrabuffer Defines the size of the RAM buffer. 

File Browser Contains options for configuring the file browser. 

Misc. Contains options for configuring compilations, burning, the database, 
the user interface, as well as advanced settings.  

LightScribe 
Contains options for configuring LightScribe recorders such as the 
print contrast (quality), default drive, and default template. 
This tab is only available if a LightScribe recorder has been installed. 

  

16.1 Compilation Settings 
The following configuration options are available on the Compilation tab: 

Check box 
Start with new compilation 

Opens the New Compilation window automatically 
when starting Nero Burning ROM. 

Check box 
Remember name of last used 

disc 

Uses the Disc name of the last compilation for a new 
compilation. 
If the check box is cleared, the Disc name is set to New 
for a new compilation. 

Check box 
Show compilation size in the 

Nero status bar 
Displays the storage volume of your files in a status bar. 

Check box 
Clear archive bits of written 

files during ISO refresh 
Deletes the archive bits of saved files. 

Check box 
Allow semicolons in Joliet 

names 

Allows the use of semicolons in addition to standard 
uppercase and lowercase letters and Unicode charac-
ters in file names in the Joliet file system. 

Check box 
Show original path with ISO 

compilation 

Lists the full path of the added files in the compilation 
screen in the Source column. 
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16.2 Cache Settings 
The following configuration options are available on the Cache tab: 

Input field 
Path for cache 

Displays the path of the Cache memory.  

You can enter the path manually or select the path in 
the browser window. 

Button 
Browse 

Opens a browser window. 
You can select a folder in which data is buffered before 
and during the burn process. 

Input field 
Minimum space on hard drive, 

which Nero should not use 

Defines the minimum storage volume on the cache drive 
that is not used by Nero Burning ROM. 

Check box 
Immediately cache files that 

have been copied from an opt-
ical drive 

Saves files that have been added to the compilation 
from a source disc in a temporary directory. 
If you clear this check box then you have to insert the 
original source disc during the burn process. 

  

16.3 Expert Features 
The following configuration options are available on the Expert Features tab: 

Check box 
Enable Disc-at-once CD over-

burning 
Enables the option that CDs can be overburned. 

Drop-down menu / Input field 
Absolute/Relative maximum 

overburning size 
Defines how much a CD can be overburned. 

Check box 
Enable DVD overburning 

Enables the option that DVDs can be overburned. 

Drop-down menu / Input field 
Maximum DVD size 

Defines how much a DVD can be overburned. 

Check box 
Enable generation of short 

lead-out 
Enables the option to write additional data to your CD. 
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Check box 
Do not eject the disc after the 

burn is complete 

Enables the option that your disc remains in the record-
er and is not ejected when the burn process is finished. 

Check box 
Enable all Nero supported disc 
types for the Image Recorder  

Enables the option that all supported recorder formats 
for the Image Recorder are available. 
It is now possible to create compilations that the in-
stalled recorder cannot burn. For instance, you can 
create a Blu-ray compilation without a Blu-ray recorder 
and create an image file with Nero Image Recorder. 

Check box 
Enable automatic renaming of 

AVCHD file extensions 

Renames the file extensions to fit the AVCHD specifica-
tions. AVCHD content on optical discs requires four 
letter extension to be detected as an AVCHD disc. 

Area 
Nero burn functions in the con-

text menu 

Allows Nero Burning ROM to be started from the shell 
context menu. The shell context menu offers various 
pertinent information and is opened by clicking a file or 
folder with the right mouse button in the Windows Ex-
plorer. 

Area / Button 
Restore 

Resets all settings back to the original factory settings. 

  

 

 

Overburning 
Overburning means writing more data on the disc than originally intended. It is 
achieved by reducing the lead-out area to a few seconds, which is sufficient in 
most cases. However, this violates the CD standard and may result in recording 
and playback errors (depends on the used recorder). 

16.4 Ultrabuffer Settings 
The following configuration options are available on the Ultrabuffer tab: 

Selection list 
Method 

Defines the memory capacity that Nero Burning ROM 
uses as a RAM buffer. 

The ultrabuffer is a second memory that enhances the 
physical buffer in the recorder.  

Input field 
Data buffer size 

Defines the memory capacity that can be manually en-
tered. 
The input field is only enabled when Manual Configura-
tion is selected in the selection list. 
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16.5 LightScribe Settings 
The following configuration options are available on the LightScribe tab: 

Area 
Print contrast 

Adjusts the desired print quality. 

Selection list 
Default LightScribe drive 

Selects the drive with the LightScribe recorder. 

Selection list 
Genre 

Specifies the genre. 

Selection list 
Current template 

Defines a template for labels. 

Selection list 
Default print resolution (DPI) 

Adjusts the desired print resolution. 

Check box 
Always print LightScribe label 

Offers the option to create and burn a LightScribe label 
automatically when burning with a LightScrive recorder. 
This tab is only available if a LightScribe recorder has 
been installed. 
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17 Technical Information 

17.1 System Requirements 
Nero Burning ROM is part of the Nero product you have installed. Its system requirements 
are the same. Detailed system requirements of this and all other Nero products can be found 
in the Support section on our Web site www.nero.com. 

http://www.nero.com/�
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18 Glossary 
AIFF 
The Audio Interchange File Format is an uncompressed audio file format from Apple® and 
represents a sort of counterpart to the WAV format from Microsoft. Files are larger than 
when using a compressed format, but the quality is higher. AIFF compressed is the com-
pressed variation. 

Archive Bit 
Archive bits are used to identify files that have been edited. A file is only resaved during the 
next backup process if it was edited (and an archive bit is thus reset).  

AVCHD 
AVCHD is an HD capturing format for camcorders. It is used for DVDs but compatible to Blu-
ray Discs. 

Book Type 
The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to 
ensure correct playback, the DVD specifications are defined in books so that all media can 
be read correctly. The specifications are defined in the so-called Rainbow Books, which are 
distinguished by means of their color (e.g. Yellow Book). 

Bootable CD 
Booting refers to loading the operating system when a computer is started. This is normally 
done from the hard drive. However, if you do not want to boot or cannot boot your computer 
from your hard drive for whatever reason, you can load an operating environment from the 
drive with a boot CD. 

Buffer 
A buffer refers to temporary memory that records and delivers data that cannot be processed 
immediately as required. The buffer also allows for continuous data flow. 

Buffer Underrun 
A buffer underrun is an interruption in the data flow in the internal memory (e.g. of the re-
corder). A buffer underrun results from an interruption in the data flow to the internal buffer. 
The buffer continues to deliver data until it is finally empty. When recording, data is fed con-
tinuously to the recorder's buffer in order to keep a steady flow of data. If the steady flow of 
data is interrupted, the media becomes unusable. Most modern recorders have a protective 
mechanism against buffer underruns. 

Cache 
Cache is a faster buffer that is used in various areas of a computer to access larger data 
volumes faster. Cache ensures a continuous flow of data. 
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CD-R 
Compact Disc-Recordable is a technology for write-once media. The Orange Book standard 
defines the storage of audio data and other computer-readable data. 

Codec 
The compressor/decompressor encodes the data for recording or saving digitally and then 
decodes it for playback. Various software codecs are available such as Cinepak, Indeo, 
Quicktime, Video for Windows, etc. Hardware codecs include MPEG, H.261, Motion JPEG, 
etc. 

Disc-At-Once 
Disc-At-Once refers to a method in which the laser in your disc burner burns the disc in one 
pass without turning off and on between each track. This method is best when recording 
Audio CDs you would like to play in your home or car stereo. 

Frame 
With an Audio CD, 75 sectors provide one second of played music. One sector consists of 
up to 98 frames; one frame contains 24 data bytes and 9 control bytes. Similarly, "frame" 
describes a full screen in television and video technology. Two successive half images result 
in a full screen within a second due to interlacing. 

Image 
An image refers to a single file on the hard drive that contains the image of a complete disc. 
A disc image can be used to create exact copies on media at a later point in time if problems 
occur during the write process or if no recorder is connected to your PC. The image requires 
as much free space on the hard drive as the contents of the original disc take up. 

Jitter 
Jitter refers to an abrupt and undesired change in the signal characteristics. Small gaps oc-
cur in the data stream as a result. Audio correction synchronizes the data by overlapping the 
sectors. This way, the gaps are not audible. 

Joliet 
Joliet refers to an extension of the ISO-9660 standard for file names. Joliet was designed by 
Microsoft in order to represent more characters. The file name can be up to 64 characters 
long and contain the letters A-Z, a-z, umlauts, as well as characters from Chinese, Japa-
nese, and Korean. 

Label 
A label refers to a label on a disc. Some drives, e.g. drives that use LightScribe or Labelflash 
technology, can transfer labels directly to special media. 

Labelflash 
Labelflash is a technology with which pictures and texts can be burned on the label or data 
side of a disc with a laser. 
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LightScribe 
LightScribe is a technology with which pictures or texts can be burned on the label side of 
discs with a laser. 

MP3 
The MPEG-1 Audio Layer 3 audio format is used to reduce the size of audio files to a frac-
tion of their original size (factor 1:10) with little loss of quality. You can estimate about 1 MB 
per minute as opposed to 10 MB for the original files. This value and the quality can vary 
depending on the complexity of the audio signal. The bit rate used can be used as a meas-
ure of quality. The higher the bit rate, the better the quality, but also the more memory re-
quired. 

mp3PRO 
mp3PRO is an MP3 codec that compresses audio files even more but in lower bit rates and 
better quality. 64 kBit/s in mp3PRO is the equivalent to 128 kBit/s in MP3. 

MPEG-1 
The Moving Picture Experts Group defined this industry standard for video and audio co-
decs. MPEG-1 is part of the MPEG compression family and has the highest compression 
rate. MPEG-1 is the format for video CDs. 

MPEG-2 
The Moving Picture Experts Group defined this industry standard for video and audio co-
decs. There is little difference between MPEG-1 and MPEG-2: MPEG-2 is a broadcast stan-
dard and better for televisions that are interlaced. MPEG-2 is used as a video format for 
DVDs. 

Multisession 
A multisession refers to completing a disc in multiple cycles. After a first session has been 
written to the disc, information can then be added in another record because the disc has not 
been finalized. 

Nero AAC 
Various MPEG-4 video and audio codecs are collated in Nero AAC and are fully compatible 
with the standard MPEG-4. Nero AG is continuing to develop these. In this way a substan-
tially higher quality of the multi-media data is achieved. Further, additional features such as 
subtitles have been implemented. 

Sector 
A sector is the smallest addressable information unit on a disc. A sector is composed of 
2,352 bytes, of which - depending on the type of disc used - different amounts are available 
as user data. A sector generally consists of a header, synchronization bits and user data. It 
may also have error recognition and correction data. 
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Track-At-Once 
Track-At-Once refers to a write method in which each track is written to the disc individually. 
The writing process is interrupted briefly after each track, i.e. the laser starts again for each 
track. With this write method, it is only possible to continue writing to a DVD sometimes and 
at a later stage. There is a pause of at least 27ms between tracks, which can be disruptive 
for Audio CDs. 

WAV 
The WAV audio format, also called WAVE or Waveform audio format, is an audio format 
from Microsoft and uses no data compression. WAV is the counterpart to the AIF format from 
Apple. 
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